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Pro Tools and Pro Tools | Ultimate Software 2021.10
on Windows 10

This Read Me documents important compatibility information and known issues for Pro Tools® and Pro Tools | Ultimate Software 
2021.10 on Windows 10 (64-bit).

Compatibility
Avid can only assure compatibility and provide support for qualified hardware and software configurations.

iLok USB Smart Key and Pro Tools Authorization

Pro Tools does not recognize iLok connected to USB3 ports (PTSW-158204)

Texas Instruments USB3 controllers are currently incompatible with iLok generation 1 & 2 USB keys. iLok keys connected to a Texas 
Instruments USB3 controller will not be recognized by Pro Tools or the ilok.com website. Connect any iLoks to USB2 ports instead. 

Pro Tools Installation

AVE remains on a system after performing a full uninstall of Pro Tools and restarting. (PT-260732)

After uninstalling Avid Pro Tools from Windows Apps & Features > Programs and Features menu and restarting, Avid Video Engine re-
mains installed. To uninstall Avid Video Engine, select it from the same menu and uninstall it as well.

Uninstalling Pro Tools does not uninstall all components that are installed with Pro Tools (PT-202003)

When you uninstall Pro Tools using the Programs and Features Control Panel, some components that are installed with Pro Tools are 
not uninstalled (such as Avid Effects, Avid Application Manager, and Avid Application Manger Helper). Use the Programs and Fea-
tures Control Panel to uninstall these components separately.

Uninstalling Pro Tools | Ultimate results in Pro Tools | First track presets being removed if both Pro Tools | Ultimate and Pro 
Tools | First are co-installed on the same computer. (PT-240899)

If Pro Tools | Ultimate and Pro Tools | First are co-installed on the same Windows 10 partition, uninstalling Pro Tools | Ultimate results 
in Pro Tools | First track presets being uninstalled. To reinstall Pro Tools | First track presets, reinstall Pro Tools | First.

Assertion error or incorrect audio device chosen when launching Pro Tools (PT-249802)

When launching Pro Tools under certain conditions, such as for the first time following a clean OS installation or after Pro Tools has 
unexpectedly quit, either an incorrect audio device can be selected as the default automatically or an assertion error dialog will display 
that prevents the use of the software. If either scenario occurs, quit Pro Tools, then relaunch while holding the “N” key to show the Play-
back Engine dialog. Select the appropriate playback device and click OK.

For detailed compatibility information, including supported operating systems, visit the Pro Tools compatibility pages online.

For the latest compatibility information—including qualified computers, operating systems, and third-party products—visit the Avid 
website (www.avid.com/compatibility).

http://avid.force.com/pkb/articles/Compatibility/Pro-Tools-12-System-Requirements
http://www.avid.com/compatibility
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Virus Alert on D-Control Resource412.dll file which is a part of the Pro Tools Installer Package (PT-213567)

Microsoft Windows users may encounter several false-positive Win64:Evo-gen (Susp) malware alerts on Korean language *.dll files 
(e.g., D-Control Resource412.dll) while running the Pro Tools Installer on systems running anti-virus software. To avoid this issue, tem-
porarily disable anti-virus software, and run the Pro Tools Installer. Consult the manufacturer of your anti-virus software for more in-
formation.

Installation of QuickTime Windows may fail with a application hang (PT-243411)

The installation of Apple QuickTime may hang and must be force quit on the Windows Operating System. This can occurs regardless 
of your Pro Tools installation. If you encounter this issue, install all Microsoft Windows updates available for the system and try again. 
If problems persist, consult a search engine for the latest troubleshooting information as the steps to work around the problem can 
change over time based on Windows Updates installed and available status.

General Compatibility

With a built-in Soundcard enabled, such as Realtek Audio devices, Pro Tools will not launch. Assertion in “d:\ code\ protools\ 
master\ protools\ aae\ source\ aax\ cficaaxwidget.cpp”, line 994 (PT-258915)

If you are using a built-in Soundcard and Pro Tools will not launch, try the following:

1 Disable the built-in sound card (such as Realtek High Definition Audio devices) under Control Panel > Hardware & Sound > Sound 

> Manage Audio Devices, and launch Pro Tools.

2 Press and hold the N key while launching Pro Tools. When the Hardware Setup dialog opens, select a different device as the Playback 
Engine.

3 Uninstall and reinstall the audio drivers for the built-in Sound card. 

Hang on application quit after firmware upgrade or downgrade (PT-250325)

If the Pro Tools launch screen displays “Waiting for Video Engine to Quit” for an extended period of time upon completion of a firm-
ware upgrade or downgrade you can safely force quit Pro Tools and follow the firmware directions by shutting down the computer and 
chassis (if present). The firmware upgrade or downgrade will be successful. The act of force quitting will not affect the firmware up-
grade or downgrade process.

Slow HDX firmware upgrades or downgrades when running in the background (PT-250326)

If you switch to other applications while upgrading or downgrading your HDX firmware, the firmware upgrade/downgrade process runs 
much slower than expected. To avoid this issue, leave Pro Tools in the foreground and do not run other applications while upgrading 
or downgrading your firmware.

Installing standalone HD Driver 2018.12 on Windows systems with a lower version of Pro Tools installed (Pro Tools 2018.10 or 
lower) results in errors on launch and prevents Pro Tools from launching. (PT-247645)

Installing standalone HD Driver 2018.12 on systems with previous Pro Tools versions installed (Pro Tools 2018.10 and earlier) results 
in errors on launch and prevents Pro Tools from launching. To correct this issue, either update to Pro Tools 2018.12 or uninstall the 
2018.12 HD Driver and then install the HD Driver version that corresponds to the installed version of Pro Tools (2018.10 or lower).

Graphical issues with Pro Tools when using 4K resolution monitors on Windows (PT-249930)

While working with 4K resolution monitors on Windows it is recommended that you set the “Scaling performed by” parameter to “Sys-
tem” in the enabled “Override high DPI scaling behavior” option of the ProTools.exe > Properties > Compatibility tab. Using the setting 
“System Enhanced” can result in graphical issues with Pro Tools.

Pro Tools 12 and higher does not support video capture (PTSW-181456)

Pro Tools 12 and higher does not have the ability to record video to the timeline. Co-install Pro Tools 10.3.10 (or higher) on the same 
system and use an Avid Mojo SDI to record video into Pro Tools 10. The captured video can then be used in Pro Tools 12 and higher.
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When opening a session with Sound Designer II files missing the .sd2 extension, those files are listed as corrupted files 
(PT-261766)

When opening a session with Sound Designer II files that are missing the .sd2 extension, those files are listed as corrupted files in the 
Session Notes dialog. SD II files with the extension are listed as not supported. 

Can not import audio-only MOV file using Import Video or drag and drop. (PT-270744)

When importing a MOV file which contains only audio, dragging and dropping the file to the timeline or using the Import Video com-
mand results in an error. To import an audio-only MOV, use the Import Audio command.

Audio cannot be imported from a video file with an unsupported video codec. (PT-266359)

It is not possible to import audio from a video file if the video codec is unsupported.

Pro Tools 12 and higher does not allow import of WMA files (PTSW-181506)

If you attempt to import a WMA file into a Pro Tools 12 or higher session, Pro Tools cannot convert the file and posts a “file is unread-
able” message. Co-install Pro Tools 10.3.10 (or higher) on the same system, import the WMA file, and convert it to a format supported 
by Pro Tools 12 and higher. 

Single track direct output exports from Media Composer may appear in the wrong channel when imported to Pro Tools. 
(PT-247229)

(Pro Tools | Ultimate and Media Composer | Ultimate Only)

Using Pro Tools 2018.12 or higher and Media Composer 2018.10 or higher, if a single track is exported from Media Composer and the 
Direct Output, One File, .Wav file export options are enabled, the file may import into Pro Tools with the wrong channel order. To avoid 
this issue, select the File Per Track, 5.1, or 7.1 export options in Media Composer. This results in a single file that will import into Pro 
Tools with the correct channel order. Another option is to export multiple tracks with the Direct Output setting enabled. This results in 
a single file that Pro Tools treats as consisting of all mono channels.

Warning displayed when opening a session or project created in Pro Tools 12.6 or higher in a lower version of Pro Tools 
(PT-220349)

Any session or project created with Pro Tools 12.6 or higher presents a warning when opened in a lower version of Pro Tools (such as 
Pro Tools 12.5). When the session is opened following this warning, any clip effects data will be dropped from that session or project. 
If you save the session or project in the lower version of Pro Tools, the Save As dialog opens instead so that you do not overwrite the 
original 12.6 session or project.

Pro Tools 12 or higher sessions that use more than 4 gigabytes of RAM will cause Pro Tools 10 or lower to quit unexpectedly 
(PTSW-181963)

If you attempt to open a Pro Tools 12 or higher session that uses more than 4 gigabytes of RAM in Pro Tools 10 or lower, Pro Tools will 
quit unexpectedly. To open such sessions in Pro Tools 10 or lower, first reduce the amount of session RAM usage to less than 4 giga-
bytes in Pro Tools 12 or higher by removing virtual instruments that take up system memory.

Pro Tools may not maximize while an ISO or other optical media is mounted (PT-217858)

If minimized while an ISO or optical media disk is mounted, Pro Tools may not re-maximize from the Task Bar, Task Manager, or via 
Application Switching until the ISO or optical disk are ejected. To avoid this issue, ensure that no such media is mounted while maxi-
mizing Pro Tools.

OMF files that contain video are not compatible with Pro Tools 12 or higher. (PTSW-184397)

OMF sequences that contain video cannot be imported into Pro Tools 12 or higher. However, OMF sequences that contain embedded 
or referenced audio files can be imported into Pro Tools 12 and higher. To import a sequence that contains video media, use a linked 
AAF sequence.

Automatic Update Notification will not connect through a proxy server that requires authentication (108837)

Software Updater will not find an active Internet connection when behind a proxy server that requires authentication to gain Internet ac-
cess. To work around this, the client machine with Software Updater needs to be moved out from behind the proxy, or the proxy needs 
to allow HTTP access via port 80 without requiring authentication.
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Aero causes errors at lower HW Buffer sizes (103563)

With Aero enabled in Windows, Pro Tools will not play back without errors at HW Buffer sizes of 128 and below. Turn off Aero if you 
want to use lower HW Buffer sizes.

Changing Waveform Cache Versions preference blocks certain features within Soundminer (PT-228201)

If Soundminer is installed, keep the “Waveform Cache Versions” preference setting at zero, its default value. Setting this preference to 
a different value may prevent Soundminer from determining the path to the currently open Pro Tools session, which will block certain 
features within Soundminer.

Soundminer “Spot to DAW” does not work if Pro Tools preferences are corrupted (PT-230027)

If you can no longer spot to Pro Tools from Soundminer even though audio files are actually copied to the audio files folder. If this issue 
occurs, quit Pro Tools, clear the Pro Tools preferences, and relaunch Pro Tools.

Eleven Rack

Eleven® Rack Guitar Window not available in Pro Tools 12 (PTSW-184398)

Pro Tools 12 does not provide the Guitar Window for Eleven Rack that is available in lower versions of Pro Tools. Avid has made avail-
able a 64-bit standalone version of the Eleven Rack Control Window found in Pro Tools 10 and earlier. Please see the following page 
for more information about the 64-bit standalone Eleven Rack Editor: http://apps.avid.com/eleven-rack/

VENUE

VENUE systems with two HDx Option cards may not be recognized by Pro Tools | HD Native systems (PTSW-142834)

If a second HDx Option card is installed in a VENUE system, it may cause both HDx cards not to be recognized by HD Native systems. 
A single VENUE HDx Option card is recognized properly by HD Native systems, so for consistent performance it may be necessary to 
de-install the second VENUE HDx Option card.

Known Issues
The following sections document known issues you may encounter when using Pro Tools and Pro Tools | Ultimate 2021.10, along with 
workarounds if they exist.

General Pro Tools Issues

Input signal is briefly audible when starting playback with a record-armed track. (PT-268070)

If any record-armed track is receiving input signal, that signal may be briefly audible when starting playback. If you encounter this issue, 
disable record-arm on that track.

Pro Tools quits unexpectedly when disabling an internal audio device (PT-220001)

Disabling an internal audio playback device from the Windows Control Panel while Pro Tools is running may cause Pro Tools to quit 
unexpectedly. To avoid this issue, ensure that Pro Tools is closed before making any changes to the audio device in the Windows Con-
trol Panel.

Changing the Playback Engine with a project open requires that you quit and restart Pro Tools (PT-278731)

Changing the Playback Engine with a project open requires that you quit and restart Pro Tools even if the selected Playback Engine does 
not normally require this. To avoid this issue, change the Playback engine before opening or creating a project. If you do encounter this 
issue, quit Pro Tools as required, relaunch Pro Tools, and then reopen the project (File > Open Recent).
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Playback and recording fails after switching sessions with H/W Buffer Size set to 2048. (PT-252207)

Depending on the session Sample Rate, it is possible to use 2048 H/W Buffer Size in Pro Tools (sessions with Sample Rate set to 88.2 
kHz or higher). If you then open a session that uses lower Sample Rate setting that does not support a H/W Buffer Size setting of 2048 
(such as 48 kHz), Pro Tools does not playback or record. If you encounter this issue, select a supported H/W Buffer Size, such as 1024, 
in the Playback Engine dialog (Setup > Playback Engine).

When bus recording cascaded stems in any punch mode on HDX systems, recorded audio is not properly aligned (PT-271255)

When bus recording multiple cascaded tracks in any punch mode on HDX systems, recorded audio may not punch in at the correct time 
and may include some signal bleed from intermediate tracks. With HDX Classic, enable Input Monitoring on the intermediate tracks to 
avoid this issue. With the HDX Hybrid Engine, enable Input Monitoring to avoid signal bleed from intermediate tracks, but phase offsets 
may occur between recorded audio on cascaded tracks.

Bus recording from a source track with a hardware insert and No Input results in early offset of recorded audio. (PT-269111)

Internal bussing from one audio track to another audio track with a hardware insert and No Input on source track results in audio being 
recorded 700 to 1024 samples early. To avoid this issue, select any hardware input or bus for input on the source track.

32 Sample Hardware Buffer Size is not available. (PT-267468)

In some cases when creating or opening a 44.1kHz or 48kHz sample rate session after previously quitting Pro Tools from a 176.4kHz 
or 192kHz sample rate session, the 32 sample Hardware Buffer size may not be available. If you encounter this issue, re-launch Pro 
Tools and open your 44.1/48 kHz session and the 32 sample Hardware Buffer size will be available.

2048 HW Buffer Size setting not available at higher sample rates. (PT-267227)

After switching to a session with a higher sample rate, the highest hardware buffer setting may not be shown in the Playback Engine. 
Quit and relaunch Pro Tools to resolve this issue.

Playback does not start after switching from a higher sample rate session. (PT-267891)

In certain cases with the HDX Playback Engine, when closing a session with a sample rate of 176.4/192 kHz and a Hardware Buffer Size 
of 2048 samples, and then opening a 44.1/48 kHz sample rate session, you may not be able to play back the session. If this occurs, open 
the Playback Engine and change the Hardware Buffer Size to a different setting to resolve this issue.

Import Session Data with “Match Tracks” and “Main Output Assignments” option disabled adds the source track’s output 
assignment (PT-231313)

Multiple outputs can be assigned to a track if Import Session Data with “Match Tracks” was used even after toggling the “Main Output 
Assignment” option of the source track. If you encounter this issue, manually restore the original output assignment of the track.

Pro Tools 2019.10 and later does not automatically link to WAV files upon OMF import. (PT-257172)

When importing an OMF that references BWF WAV media into Pro Tools 19.10 and later, the associated WAV files do not link auto-
matically and are identified as missing. This occurs even if the media is placed in the same folder as the OMF, and all file attributes 
match. To bring the media online, perform a manual relink when prompted. Note this only occurs with OMF; AAF is unaffected.

Additionally, if the missing WAV files are located in the same folder as the OMF, navigating within the Relink window is significantly 
slower (delays between clicks and results). To avoid this issue, place the OMF in a different location than the associated media before 
importing the OMF. As long as the OMF and media are separated, relink navigation works correctly.

AAF-associated WAV files exported from Pro Tools 2019.12 will not AMA-Link in Media Composer 2019.11. (PT-256851)

If an AAF referencing WAV files is exported from PT 2019.12 and then imported into Media Composer 2019.11 (and earlier) using 
AMA-Linking, the WAV media is offline. To bring the media online, place the exported WAV media into an OMFI MediaFiles folder 
accessible by Media Composer.

Pro Tools quits unexpectedly when importing a track during playback (PT-234220)

Pro Tools may quit unexpectedly when importing an audio track from another session (Import Session Data) during playback where the 
imported track replaces an audio track in the session that is being played back during the import. If this occurs, restart Pro Tools and re-
open the session. To avoid this problem, stop playback before importing audio tracks from another session.
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Pro Tools does not launch (58531)

Pro Tools will not launch if hardware drivers are not installed or if there are no Inputs or Outputs set in the Control Panel for your audio 
interface. If Pro Tools does not launch, be sure the drivers for your audio interface were installed before Pro Tools installation. For M-
Audio and some third-party interfaces, if the drivers are already installed, go to the Control Panel for your audio interface and make sure 
either the Analog or S/PDIF Inputs and Outputs are enabled.

Unable to create Pro Tools Session on NEXIS using Windows client if real-time virus protection enabled. (SSENG-28533)

When using Pro Tools with NEXIS on a Windows client, add Pro Tools as an exclusion from the anti-virus scans to be able to create a 
Pro Tools session.

Pro Tools quits unexpectedly when manually moving clips with sections out of the session length bounds (PTSW-188679)

Clips that are moved outside of the session bounds may cause Pro Tools to quit unexpectedly. To avoid this, adjust the Session Length 
setting (in the Session Setup window) to ensure that there is sufficient time for all material in the session.

Pro Tools is intermittently unresponsive after playing back high raster video, exiting, and then quickly relaunching (PT-255169)

If you exit Pro Tools right after playing back video with a high rater size (2K, UHD, 4K), and then relaunch it right away, Pro Tools may 
be intermittently unresponsive. This is more likely to happen if you encounter a playback error right before exiting Pro Tools. To correct 
this issue, exit Pro Tools and then relaunch it after a pause.

Pro Tools is slow to launch and may become unresponsive if a CD or DVD is mounted by your system (PT-201624)

If a CD or DVD is mounted by your system, Pro Tools takes an exceptionally long time to launch. Additionally, Pro Tools may become 
unresponsive while a CD or DVD is mounted by your system. To resolve this issue, exit Pro Tools, eject the disc, and then relaunch 
Pro Tools.

Error messages are displayed while unzipping the downloaded Pro Tools installer zip file (PTSW-181403)

While unzipping the downloaded Pro Tools installer .zip file, errors are displayed saying that certain files are missing. If you proceed 
and run the unzipped installer, then these files will be reported missing. To avoid this issue, move the downloaded .zip file to the root 
(top most) directory of a volume first (such as the C: drive), and then unzip.

Short automation lines to –inf attenuate audio too early. (PT-276702).

If you are using automation lines that attenuate to or from –inf, and the line is approximately 60ms or less, add additional breakpoints 
along the line to improve accuracy and avoid this issue. This can help even though the added breakpoints do not change the curve of the 
line.

Shifting an Edit Group containing frozen tracks removed clips and effect automation on non-frozen tracks (PT-264403)

Shifting the contents of an Edit Group with Frozen Tracks can remove Clips and effect automation on non-frozen tracks. To avoid this 
issue, suspend the group before Shifting the contents.

Mute/unmute with dense automation causes level drop. (PT-273775)

In certain conditions, the Volume level may be lower than the original (~7dB) on the tracks with dense automation while toggling the 
Mute button, or changing automation mode from “Read” to “Off” and back to “Read” during the playback.

Dense automation results in –9155 Error (PT-249098)

Due to higher voice counts available on Pro Tools Native systems, you might encounter AAE –9155 errors when many automation pa-
rameters are written to multiple tracks on the same sample. If you regularly encounter “AAE –9155 Automation Too Dense” error mes-
sages at the exact same point try the following:

• Select all automation and choose Edit > Thin All Automation.

• If the session contains many parameters written at the exact same spot, try removing some of the unnecessary automation by de-
leting it or changing the Automation mode from Read to Off on respective tracks.

• If the Automation was written to any unnecessary tracks in the session, make those tracks Inactive.

• Select the suspect automation and nudge it by a sample or two.
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Data lost while shifting automation across multiple tracks with mixed channel widths. (PT263781) 

When using the Shift command to move automation data on multiple tracks, if one of the tracks is a wider channel width than mono, 
automation on one track can be replaced by automation from another. In some cases, automation can be lost. If this occurs, Shift auto-
mation on tracks of different channel widths separately.

Tracks List scroll bar gets stuck at high voice counts (PT-236416) 

(HDX Systems Only)

If you encounter this issue, use scroll wheel on your mouse or trackpad to scroll through the Tracks List.

The Mix Window cannot be expanded past a certain vertical size (PT-236038)

The Pro Tools Mix Window has a vertical size limit. As a result, the window may not be stretched to fill the entire screen on high res-
olution monitors without scaling. If you encounter this issue, it is recommended that either the display be scaled to more fully fit the 
screen, or that you scroll through the Mix Window to view areas that might otherwise be out of view.

Clicking on a Pro Tools window that may be visible will not always bring Pro Tools to the foreground, especially if a process 
is running in Pro Tools (such as Bounce to Disk)

If Pro Tools is not the foreground application, you can bring it to the foreground by doing one of the following:

 Click the Pro Tools icon in the Windows Taskbar.

 Press the Start+Tab keys to bring the Pro Tools application to the front.

OK button in the Tempo Change dialog is grayed out after using manual tempo in a previous session. (PT-235174)

If you encounter this issue, toggle the Conductor button off and on. The OK button should then be usable in the Tempo Change dialog.

Session templates retain I/O settings and some preferences, display settings, and window layouts (PTSW-47133)

Pro Tools session templates retain the I/O settings and some of the preferences, display settings, and window layouts from the system 
on which the template was created. Consequently, new sessions based on a template restores several session properties from the original 
system. These properties are retained by Pro Tools until you change them or another session or template is opened that replaces them. 
This also means that if a new blank session is created after using a template, the properties from the template will be used for the new 
session.

The properties retained from templates include default track height, view settings, window size and position, and I/O Setup. You can up-
date templates by making the desired changes, using the File > Save as Template command (be sure to select the “Install template in 
system” option), and then selecting the template you want to replace.

Trying to load a session from an unmapped network drive results in the error: “Pro Tools application has stopped working” 
(PTSW-125913)

When trying to load a session from an unmapped network drive, the error “Pro Tools Application has stopped working” will occur. To 
avoid this problem, be sure to map the network drive to a drive letter, set up the drive as transfer volume, and then open the session.

Session saved with Edit window closed may result in hidden tracks being shown and closed folders being opened upon 
session reopening. (PT-258820 and PT-260627)

If a session was saved in a state with some tracks explicitly hidden and an Edit window closed, reopening it may result in hidden tracks 
being shown. The workaround is to always save the session with the Edit window open.

Pro Tools does not play back immediately after importing a large and complex AAF sequence (UME-905)

Importing a complex AAF sequence that contains many video files and edits may cause Pro Tools to be in a Play/Pause state after all 
files have finished linking. This may also happen when reopening the session. If you encounter this, stop the transport, wait 30 seconds, 
and then attempt playback again. To avoid this problem completely, you can bounce the video and re-import, or request that the video 
editor flatten the video upon export.
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Pro Tools reports AAE Error 2 (PT-210384)

You may encounter AAE Error 2 if you have two or more volumes on your system with the same name. To avoid this issue, ensure that 
each volume on your system is uniquely named.

Pro Tools becomes unresponsive when bouncing certain multichannel paths to MP3 (PT-217391)

The only multichannel format Pro Tools supports for bouncing to MP3 is 5.1. Bouncing any other multichannel format to MP3 (LCR, 
LCRS, QUAD, 5.0, 6.1, 7.0 SDDS, 7.1 SDDS, 7.0, and 7.1) results in Pro Tools becoming unresponsive and you will have to force quit. 

Offline Bounce takes much longer than expected (PT-202888)

Offline Bounce times can increase significantly in sessions that have output and input assignments cascaded across tracks (for example: 
Track 1 output is assigned to Track 2 input, Track 2 output is assigned to Track 3 input, and so on).

Bouncing Mix from UHD or 4K raster J2K source to H.265 fails. (PT-266089)

Pro Tools displays an error when attempting a bounce to a H.265 with UHD or 4K raster J2K source on the timeline. To avoid this error, 
either re-encode the source J2K clip to a different codec, or choose a different destination codec.

Windows erroneously reports that Pro Tools has stopped responding

Clicking on the splash screen while Pro Tools is launching can result in a Windows error stating that Pro Tools has stopped responding. 
Pro Tools is actually still loading normally and will finish launching if you just don’t do anything or if you click “Wait for the Program 
to Respond.”

Automation is replaced instead of overlaid when using Adjust Session Start Time to Match Source Start Time when importing 
session data (PTSW-149273)

Automation can sometimes be replaced instead of overlaid when using Adjust Session Start Time to Match Source Start Time when im-
porting session data. This issue may occur if the source session start time (of the session being imported) is earlier than the current ses-
sion start time. This issue can be avoided if you instead import the session data from the session with the later start time into the session 
with the earlier start time. You must also not enable the Adjust Session Start Time to Match Source Start Time option, and select Main-
tain Absolute when prompted.

Start+L launches the Switch Admin User prompt instead of nudging cursor to the left (PTSW-17100)

Start+L Key launches the Switch Admin User prompt instead of nudging the cursor to the left. As a workaround, enable Keyboard Focus 
(A...Z) and use the L key.

Auto Low Latency Monitoring is lost when opening a session created in Pro Tools 12.6 or higher in versions of Pro Tools lower 
than 12.6 (PT-219356)

If a session is saved with Auto Low Latency Monitoring (“Blue Mode”) enabled in 12.6 or higher, it is disabled when that session is 
opened in versions of Pro Tools lower than 12.6 (in 12.5 for example). You will have to re-enable Auto Low Latency Monitoring if de-
sired. This issue does not occur when opening sessions in Pro Tools 12.6 and higher that were saved with Auto Low Latency Monitoring 
enabled in a version of Pro Tools lower than 12.6.

No sound when previewing audio files in Workspace if Delay Compensation was enabled during playback (PT-229609)

If you enable Delay Compensation during both session playback and audio file preview in a Workspace browser, Workspace preview 
is silent until session playback is stopped. To avoid this issue, enable Delay Compensation before starting session playback and preview 
in a Workspace browser.

Audio clips on tick-based tracks do not play at the correct tempo after opening a Reason song with a different tempo 
(PTSW-34086)

Audio clips on tick-based tracks do not play at the correct tempo after opening a Reason song with a tempo that is different from the one 
in your session. To correct this, make any tempo change via the Conductor track or the Manual Tempo input and the clips will play back 
correctly.
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AAE Error –9093 during playback when using Rewire (PT-273476)

When using a Rewire panel application in a Pro Tools session, you may encounter an AAE Error –9093 during playback. If this occurs, 
close and reopen the session to restore the ability to playback the session.

Cannot run Reason or Record as ReWire clients if they have not first been launched and set up as a standalone application 
(PTSW-133070)

Reason and Record need to be launched and setup as a stand-alone applications before running them as a ReWire clients with Pro Tools. 
Do the following:

• Launch Reason or Record in stand-alone mode and follow the on-screen instructions.

• Quit Reason or Record.

• Launch Pro Tools and insert Reason or Record as a ReWire plug-in on an audio, Auxiliary Input, or Instrument track.

Cannot drag and drop media files from the Desktop to Pro Tools (Windows 8 Only) (PTSW-181311)

If UAC is enabled on Windows 8, dragging and dropping media files from the Desktop is disallowed. To avoid this issue, disable UAC.

When importing audio from a network share, “file is unreadable” or other errors occur (PTSW-149570)

When importing an audio file from a network share using the Import Audio dialog or a direct shortcut to the share, Pro Tools may dis-
play an error such as “The audio file is unreadable by Pro Tools” or “The mp3 cannot be imported because QuickTime is not installed,” 
even though QuickTime is installed on the system. If this occurs, map a drive letter to the network share and use the drive letter in the 
Import Audio dialog to navigate to the audio file. 

Importing MP3 or MP4 files without QuickTime installed (PTSW-61863)

If Pro Tools has been run on a system on which QuickTime was not present, but then QuickTime is installed later, there is the possibility 
that Pro Tools has indexed QuickTime files as “Unknown.” These files will remain as unknown even after QuickTime has been in-
stalled. If this occurs, either delete DigiBase Database files and try again, or navigate in the browser to any “Unknown” QuickTime file 
and select “Update Database for Selected.”

Conversely, if Pro Tools has been run on a system with QuickTime present, but then QuickTime is uninstalled, there is the possibility 
that QuickTime files have been indexed as known audio file types that can no longer be understood by Pro Tools since QuickTime is 
now absent. If this occurs, delete all database files and try again.

Subfolders supporting presets menus cannot go deeper than 9 nested folders on windows without issues (PT-236243)

Do not create subfolder tree deeper than 9 subfolders for presets. You will not be able to navigate father even if there are other sub-fold-
ers (they will be seen only via Explorer).

Issues with Kensington mouse and drivers

The following may occur when using a Kensington mouse with Pro Tools: 

• Alt key sticks when Zooming (61823) 

• Stuck Shift Key (62376)

• Stuck Control Key (61830, 62066, 61980, 61988, 62348, and 62559). 

To clear stuck keys, press them again. If problems continue, try removing the Kensington drivers. 

Move and Relink does not work. (PT-264552)

When many files are selected, Move and Relink throws assertion and does not work. The first one or two selected files may be moved 
before the assertion is thrown, but then the rest are not moved. Use Copy and Relink instead. Once Copy and Relink has finished, man-
ually delete the original files.
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Error message “Could Not Complete Your Request because the System Cannot Find the File Specified (2)”
(# 50454 and # 50457)

This message can appear while logged into a non-administrative account and doing either of the following: 

• Performing destructive AudioSuite processing

• Locking files in the Workspace browser 

This is possibly because the audio file has read-only permissions. In order to correct this, you must be able to log into an administrative 
account in Windows and change the permissions of the audio file so you have full read and write access to the audio file. If you do not 
have administrative access of the computer, then you must either contact the administrator of the computer to resolve this problem, or 
use the File > Save Copy In command to create a copy of the session with all of its audio files.

Groove Templates (43997)

Pro Tools will be unable to retrieve custom Groove Templates that are saved in an incorrect directory. Groove Templates should be 
saved only within the “Grooves” folder.

Clip Groups can be dragged to tracks in Playlist view even though Clip Groups are not supported in Playlist view 
(PTSW-152707)

It is possible to drag a clip group to a track in Playlist view even though clip groups are not supported in Playlist view. Normally, when 
switching to Playlist view from another track view, any clip groups on that track are automatically ungrouped. While clip groups 
dragged to tracks in Playlist view may appear to work properly, it is recommended that you ungroup them while in Playlist view to en-
sure proper behavior.

Importing tracks with Import Session Data clears the Undo queue (51775)

It is documented in the Pro Tools Reference Guide that importing tracks through Import Session Data clears the Undo queue. More spe-
cifically, the Undo queue gets cleared when Main Playlist Option is set to “Import - Replace existing playlists.” The Undo queue does 
not get cleared if the option is set to “Import - Overlay new on existing playlists” or “Do Not Import.”

Rendering Clip Gain or Clip Effects on multi-channel audio clips in an interleaved session results in multi-mono files 
(PT-214780)

In an interleaved session, rendering Clip Gain or Clip Effects on a multichannel audio clip creates mono audio files for each channel 
rather than the expected single interleaved, multichannel audio file.

Real-Time Fade Adjustment tool can display the fade preview outside of the Timeline under certain Window Scrolling 
conditions (PT-220418)

If the area before the start of the Timeline is visible when using Continuous Window Scrolling or if the Center Playhead option is en-
abled, and the area before the start of the timeline appears on-screen, then adjusting a fade using the Real-Time Fade Adjustment Tool 
can cause the fade preview to appear outside of the fade boundary or Timeline. To avoid this issue, only use the Real-Time Fade Ad-
justment Tool in No Scrolling, After Playback, Page scrolling modes, or when the start of the Timeline is off-screen.

Recording track group output featuring 90º volume automation changes while writing VCA automation can result in unwanted 
fades (PT-222834)

If audio clips on a track within a track group feature sharp 90º volume automation changes and the track group has a VCA assigned to 
it, bus recording the output of the audio track to another audio track while VCA automation is being written may result in the new re-
corded audio fading in and out around the 90º volume automation changes. To avoid this issue, record any VCA automation first and 
then record the track group output in a separate record pass.

Unrendered mix and match AAFs will not properly import (PTSW-181825)

If the error “A video file and its associated clips were removed because its timecode rate is incompatible with the project type” appears, 
it is likely that your AAF contains unrendered mix and match video. To avoid this, render mix and match AAFs from Media Composer 
before or during export.
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AAF files that contain AMA-linked audio cannot be imported (PTSW-182322)

Pro Tools cannot import AAF files that contain AMA-linked audio files. AMA-linked audio must be imported or transcoded in 
Media Composer before the AAF is exported.

With the Pro Tools Web browser, links to external sites do not work as expected (PTSW-145325)

In the Pro Tools Web browser, navigating to external sites using links from Avid web pages (such as links to social networks like Face-
book and LinkedIn) may not work as expected. For the sake of security, the Pro Tools Web browser is restricted to avid.com pages. If 
you want to browse sites other than avid.com, or share avid.com pages with friends, use the Launch Page in External Browser feature 
to view the page in your default Web browser and navigate from there.

Clip names appear incorrectly after selecting Field Recorder channel matches, or expanding to new tracks (PTSW-136012)

This can occur if the file name of a Field Recorder channel match contains a hyphen followed by a number greater than zero. Pro Tools 
names new clips by incrementing the number after the hyphen. If a field recorder file is already named in this way (such as “Filename-
01”), then new clips created by selecting a Field Recorder channel match or by expanding a track may have names different from the 
parent file. To avoid this situation, avoid using hyphens in Field Recorder file names.

Field Recorder matches appear offset after AudioSuite rendering if the session timecode rate does not match the file timecode 
rate (PTSW-152147)

If a portion of a file has been rendered with an AudioSuite plug-in, an offset can occur when expanding field recorder matches in cases 
where the session timecode rate does not match the timecode rate of the audio file. To avoid this issue, you can either render the whole 
file with AudioSuite (rather than only a portion of the file), or use Whole File mode when rendering AudioSuite processing.

External Field Recorder matches do not show up after an initial index pass (PTSW-180659)

If external field recorder matches do not show up on a field recorder track after the initial index pass, save and reopen the session.

Editing

Fades are not restored after moving clips using the Grabber tool (PT-207491)

With Layered Editing enabled, moving a clip that partially covers a fade on another clip with the Grabber tool so that it no longer covers 
the fade does not restore the fade to its original duration. You will need to manually trim the fade to its original duration.

The Undo command does not remove a clip copied to a playlist by virtue of the Send Overlapped Clip to New Playlist preference 
(PT-222824)

When the Send Overlapped Clip to New Playlist preference is enabled, and you move a clip completely over another, the overlapped clip 
is moved to a new playlist. However, if the track is not in Playlists view, Undo restores the clip on the main playlist, but it does not re-
move the clip from the alternate playlist. You will have to manually remove that clip from the alternate playlist if you so desire.

Designating the Main playlist as the Target playlist after a new playlist was created and then undone may result in Pro Tools 
quitting unexpectedly. (PT-236287) 

If a track already has an alternate Target playlist and its creation was undone, then trying to set Main playlist for the same track as the 
Target playlist may result in Pro Tools quitting unexpectedly. 

No indication of designated target playlist in Playlist selector menu (PT-237313)

When a track contains one playlist that is the Target playlist, the blue target icon does not appear next to the playlist name in the Playlist 
menu. This issue is resolved once another playlist is created.

Looping clips does not send fully overlapped clips to an available playlist (PT-219668)

With both Layered Editing option (Options > Layered Editing) and the Send Fully Overlapped Clips to Available Playlist While Editing 
preference enabled (Setup > Preferences > Editing), clips that are fully overlapped by a looped clip (Clip > Loop) are not sent to an avail-
able playlist. Manually move clips that will be fully overlapped by the looped clip to another playlist before looping the clip.
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Fully overlapped clip not sent to new playlist if the clip is overlapped by creating a fade (PT-220888)

When a clip is fully overlapped by the creation of a Fade In or Fade Out, the overlapped clip is not sent to a new playlist even though 
the Send Fully Overlapped Clips to Available Playlist While Editing preference is enabled. To avoid this issue, create a shorter fade and 
then extend it to fully overlap the clip in question. That clip is sent to a new playlist. Alternatively, manually move the clip to a new play-
list.

With Layered Editing enabled, deleting overlapping clips that were created with Duplicate or Repeat can result in some 
overlapped clips being unexpectedly edited as well (PT-220491)

With Layered Editing enabled, deleting overlapping clips that were created with Duplicate or Repeat can result in some overlapped clips 
being unexpectedly edited as well depending on the order in which the overlapping clips are deleted. To avoid this issue, delete any over-
lapping clips in order from left to right.

EditorTools unable to communicate with Pro Tools if the Task Manager window is open (PT-255202)

If the Task Manager window is open, EditorTools is unable to communicate with Pro Tools. Close the Task Manager in order for 
EditorTools to function properly.

Projects and Collaboration

It is strongly recommended that you do not log in to the same project on multiple systems using the same Avid Master Account 
login

When you are connected to the internet and then you open a Pro Tools Project, Pro Tools checks to see if there are any other machines 
that are logged in to the same Avid Master Account and both with the same project open. If the project is detected as being open on an-
other system it should be closed. This prevents the project bundle on the cloud from becoming corrupted by competing updates from 
multiple systems using the same account. To avoid this situation, it is strongly advised that you close projects when leaving systems idle 
if it is possible that you will be working on the same project from another computer with the same Avid Master Account.

Pro Tools doesn't indicate incoming contact requests (MP-5538)

When using Avid Link in Pro Tools, as opposed to using the desktop client, incoming contact request notifications are visible in the 
Home screen under the Notifications tab. Go to the Avid Link menu and choose Home, then navigate to the Notifications section by 
clicking Notifications.

Playing back recorded MIDI CC data incorrectly triggers the Upload Track Change button (PT-255960)

When playing back MIDI CC data on a shared MIDI or Instrument track, Pro Tools may incorrectly indicate changes on that track for 
upload. Since clicking the Upload Track Changes button synchronizes the track with server, it is recommended do this until you have 
made additional changes to the track.

“Failed: couldn't connect to server...” errors encountered after restarting your computer (PT-225252)

Cloud Client Services require a few minutes to start, so if you encounter “Failed: couldn't connect to server...” errors when using 
Pro Tools collaboration features right after a system reboot, just wait a few minutes for Cloud Client Services to start and then relaunch 
Pro Tools.

Clip Effects settings are lost when sharing tracks with Pro Tools 12.5.x (PT-220478)

Track collaboration between Pro Tools HD 12.6 and lower versions of Pro Tools will result in losing Clip Effects settings on shared 
tracks. Earlier versions of Pro Tools drop clip effects settings from tracks that are shared from Pro Tools HD 12.6. There is no warning 
when Clip Effects settings are lost while collaborating. To avoid this issue, render Clip Effects for all clips with Clip Effects on tracks 
you want to share with any collaborator running a lower version of Pro Tools.

Additional Playlists indicator does not appear on shared tracks with collaborators' systems (PT-219746)

If you duplicate a playlist on a shared track, the Additional Playlists indicator does not light for collaborators. Subsequently making a 
change to the alternate playlist, however, does notify collaborators.
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Projects may not synchronize to Avid Cloud after remaining open overnight (PT-220208)

After a Project has been open for a protracted period of time, saving to the Avid Cloud may not succeed. If you see a Project upload not 
completing in the Task Manager, it is recommended that the Project be saved and closed, and that you sign-out and then back in again. 
You should then be able to complete the Project upload.

Disconnecting from the internet or closing a project during project synchronization can result in failed project synchronization 
(PT-202643)

To prevent potential synchronization with projects, do not disrupt the project synchronization while it is in progress. Avoid disconnect-
ing from the internet, turning off WiFi, shutting your laptop, or quitting Pro Tools during this time. To monitor the progress of project 
synchronization, choose Window > Task Manager.

After opening a project that has not completely uploaded, you will need to reboot your computer to continue working on the 
project (PT-202615)

If your project does not completely upload to your cloud account, quit Pro Tools, reboot the computer, and then launch Pro Tools | First 
to continue working on your project.

“There was a problem uploading the project” error (PT-204847)

If your Documents folder (e.g., C:\Users\JohnDoe\Documents) is configured with Windows encryption, you may encounter a “There 
was a problem uploading the project” error. To avoid this error, right-click the Pro Tools folder and “disable encryption.”

Removing a collaborator from your project may not relinquish ownership of tracks claimed by that collaborator (PT-211627)

When a collaborator who has ownership over shared tracks is removed from a project that you own, their track ownership may not be 
automatically relinquished. Should this issue occur, click the Track Ownership button for these tracks and ownership should be returned 
to you after about five minutes.

Project uploads may pause while Shuttle Lock is active (PT-213277)

Entering Shuttle Lock mode while project uploads are in progress may temporarily prevent uploads from finishing until the playhead 
comes to a stop. To avoid this issue, confirm that all uploads have completed in the Task Manager before using Shuttle Lock mode in 
a project.

“Expand Alternates To New Playlists” may not trigger track or project uploads (PT-212809)

When a track has loop-recorded alternates that are not on any playlists, choosing to “Expand Alternates To New Playlists” may not trig-
ger an auto-upload or allow manual uploading using the Track or Toolbar upload buttons. If this issue is encountered, making any 
change or edit to the track or its playlists will enable uploading with the Track upload button.

Edit selection moved to the wrong playlist on a shared track (PT-220200)

On a shared audio track received from a collaborator who reordered the track's playlist lanes (by click-dragging the lanes up and down), 
the Move To... commands in the Right-click menu sends the selection to the wrong playlist. The collaborator reordering lanes and shar-
ing can be on a Mac or Windows system, however, only Windows systems will have the issue on the receiving end. To avoid this issue, 
make sure that collaborators do not manually reorder playlist lanes on shared tracks.

DestructivePunch Enable does not check available disk space before processing, which leads to Pro Tools becoming 
unresponsive if all available space is used. (PT-279522)

When preparing tracks for DestructivePunch, Pro Tools will attempt to use any necessary disk space to create contiguous files for each 
record-enabled track. If all available disk space is used before processing completes, Pro Tools becomes unresponsive. To avoid this is-
sue, be sure there is enough disk space before enabling DestructivePunch. To conserve space, adjust the “DestructivePunch File Length 
setting in the Operation Preferences (Setup > Preferences) to cover only the necessary length.

DestructivePunch record passes are not transmitted to collaborators (PT-212577)

Using Destructive Punch to update a shared file does not transmit a track change and the file is not updated on collaborator systems.
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Changed Display Name in Artist Chat is not updated in the Dashboard until signing out and signing back in (PT-209796)

After making a change to the Display Name in your Artist Chat profile, the Pro Tools Dashboard is not updated with the new user name 
until you sign out and sign out and back in. 

Artist Chat messages of 1,800 characters or more may not be received or even sent (PT-211701 and PT-214391)

Attempting to send an Artist Chat message of 1,800 or more characters can appear to send but may not be received by other users in the 
chat or they may not be sent at all. The actual maximum limit for Artist Chat messages is 2 kilobytes per message. It is recommended 
that uncommonly long messages be posted in shorter segments.

Dropped Keystrokes in Artist Chat and Sign On Window (PT-211627)

In some cases keyboard keystrokes will fail to be transmitted to the Sign On and Artist Chat windows. 

Pasting a text string inside of the “< >” characters into Artist Chat results in a blank entry (CLOUD-3285)

Any text in contained by “<” and “>” is disallowed for security reasons. Please do not use these characters in Artist Chat messages.

When sharing a track with plug-ins such as Melodyne or Space, only the waveform cache inside the plug-in is uploaded and 
shared, but not the referenced audio file (PT-212607)

Media assets for Plug-ins (such as Melodyne or Space) that use external media, like a waveform cache or impulse responses, may not 
always be copied with the shared tracks to the cloud for use by other collaborators.

Ableton Link 

Pro Tools is not seen by other Ableton Link peers after leaving and rejoining session. (PT-263719)

Sometimes when a computer running Windows leaves an Ableton Link session, then tries to rejoin, they are not seen by the other Win-
dows systems until they also leave the session and rejoin.

Pro Tools goes out of sync with an Ableton Link session after receiving a tempo change. (PT-263560)

When Pro Tools receives a tempo change while synced to other peers with Ableton Link, it may lose phase alignment synchronization. 
It remains tempo locked, but the position in the cycle is incorrect. This can be corrected by restarting the Pro Tools transport to re-es-
tablish sync.

Count Off is unavailable with Ableton Link

Count Off is unavailable with Ableton Link. If Count Off is enabled, enabling Ableton Link disables Count Off.

Ableton Link is disabled with Sync X or SYNC HD (PT-270144) 

Because Ableton Link can interfere with the operation of synchronization peripherals it is disabled with Sync X or SYNC HD enabled.

I/O Setup

Do not assign the Audition path to Ambisonics Output paths (PT-232689)

Ambisonics Output paths should not be used for audition paths. If you assign an Ambisonics Output path as the Audition path, it will 
not work. Only use non-Ambisonics Outputs paths for the assigned Audition path.

I/O Setup files can be saved with illegal characters when Enforce Mac/PC Compatibility option is not enabled (60730)

When importing I/O Setup files (.pio files) from Mac sessions that were not saved with the Enable Mac/PC Compatibility option en-
abled, files that have illegal characters are not converted successfully—illegal characters do not get replaced with an underscore.
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Master Faders assigned to mapped output busses function only on that specific bus, not for the output channel as a whole 
(PTSW-127517)

Because a Master Fader works on a bus, not on an output path or output channel, there may be certain configurations in which the level 
sent to the physical I/O is not reflected on any meters in the Pro Tools application. If the configuration includes output subpaths or has 
multiple busses assigned to a single output path, the overall signal level from these combined sources (including any clipping indication) 
will only be displayed on the interface itself. You can avoid using multiple output paths or output busses simultaneously by routing your 
sources to a single mapped output bus and assign a Master Fader to that.

2nd port of MTRX DigiLink I/O card does not show inactive in the I/O Setup in 192 kHz sessions (PT-252964)

The second DigiLink Mini port on MTRX DigiLink I/O expansion cards is unavailable at sample rates of 176.4 kHz and 192 kHz.

Opening a session saved to .ptf (Pro Tools 7–9) from Pro Tools 12.x or higher in Pro Tools 8.1 or lower results in incorrectly 
mapped IO (PTSW-194443)

For any session saved to .ptf (Pro Tools 7–9) from Pro Tools 12.x or higher requires that IO Settings be manually corrected when open-
ing that session with Pro Tools versions 8.1 and lower. Manually map the correct IO settings in the IO Setup before playing back the 
session.

File and Disk Management

Auto-backups are not created during playback or recording (PT-231812)

Auto-backups are not saved while Pro Tools is playing back or recording. To ensure your work is saved during long periods of playback 
or recording, either manually save during playback or recording, or after stopping playback or recording. Auto-backups continue to 
function as expected when the transport is stopped.

Auto-saving with external hard drives that have little free space can result in data loss (PTSW-32639)

When recording to hard drives that do not have much free space available and when the Auto-Save preference is turned on, it is possible 
to completely fill your record drives, and cause data loss. While this occurrence is rare, it can also result in external drives that will fall 
offline and not be able to used on the Windows system. It is recommend that you do not allow your record drives to become completely 
full, and that you manually back up your projects on a regular basis.

Pro Tools unable to relink to audio files and fade files that have illegal characters when Enforce Mac/PC Compatibility is not 
enabled (PTSW-57355)

A Pro Tools session is unable to relink to audio files and fades that have illegal characters if the session was copied without the Enable 
Mac/PC Compatibility option enabled. The workaround is to open the DigiBase Project Browser and manually relink each file by 
Unique ID.

Importing interleaved BWF files exported from Pro Tools 10 and higher into Pro Tools 9.0.x (and lower) may cause Pro Tools 
to quit unexpectedly (PTSW-151579)

When exporting any greater-than-stereo multichannel interleaved WAV (BWF) files other than 5.1 from Pro Tools 10 and higher, and 
then importing them into Pro Tools 9.x or lower, Pro Tools quits unexpectedly. To avoid this problem, export audio files for import into 
lower versions of Pro Tools in another file format (such as AIFF or multi-mono).

Pro Tools quits unexpectedly when indexing Workspace or Field Recorder Search outside of a session. (PT-251446)

If Pro Tools consistently quits unexpectedly when indexing a directory with the Workspace, or when using the Select Areas to Search 
functionality with field recorder workflows, this might be resolved by trashing your Workspace database files. To do this, clear the con-
tents of the following folder: <boot drive>:\Users\Public\Pro Tools\.

Unable to open Mac sessions from Workspace if illegal characters in session name were converted to underscore symbols 
(PTSW-52463)

You will not be able to open a Mac session from the Workspace if the session name contains illegal characters that were converted to 
underscores. The workaround is to open the session using the File > Open command.
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OP-1a MXF files appear only as audio files in the Workspace (PT-267125)

OP-1a MXF files may contain both video and audio media. However, OP-1a MXF files only appear as audio files in the Workspace.

Multiple files with the same name do not relink properly when Save Copy In command is used with Preserve Folder Hierarchy 
option (PTSW-28069)

When saving a session copy with Preserve Folder Hierarchy checked, files with the same name may not relink properly when using 
Manual Relink. When opening the session copy, use Automatically Relink to locate the correct files. If the session has already been 
opened using Manual Relink and some files are still offline, select Relink Offline in the Project Browser to manually relink the remain-
ing files.

Missing files when opening a session created by a lower version of Pro Tools (37572)

When opening some sessions created by a lower version of Pro Tools, some files may be missing. You should be able to relink these 
files in the Relink window by Name and Duration. In some cases Match Format may not result in found links.

After Relinking files the Relink window does not retain its “revealed/open” status (PTSW-178130)

Although the checkbox remains selected, the reveal status of volumes is not retained if the Relink window is automatically reopened. 
Be sure to reveal the volumes so that the enabled checkboxes are visible in order to reliably relink to missing files. 

“Access Violation” on playback of read-only sessions

Pressing play in a session recently restored from CD-ROM may result in a dialog stating “Access Violation.” This happens if the session 
(and its audio files) are marked with the Read-Only flag. If you do not know how to remove the Read-Only flag from your files, please 
consult Windows Help.

When relinking audio files, mismatched channel widths are not found (PTSW-189868)

When relinking audio files, it is possible to link files with different channel widths. This is not a supported workflow and may have un-
predictable results. Ensure that the channel width of linked files match the channel widths of clips in the session to avoid this issue. 

Elastic Audio

Maintaining phase coherency with Elastic Audio pitch processing (PTSW-20602)

When there is Elastic Audio Pitch processing enabled on a track, switching from Polyphonic, Rhythmic, or X-Form to Monophonic or 
Varispeed can disrupt phase coherency. To preserve phase coherency in this case, be sure to clear all Elastic Audio Pitch processing 
from the track before switching to the Monophonic or Varispeed algorithm.

Drift in an audio file may occur when using Elastic Audio and the Monophonic or X-Form algorithms (PTSW-33768)

Drift in an audio clip may occur when using elastic audio depending on how much the clips is expanded or compressed when using the 
Monophonic algorithm. If you are using elastic audio with material that contains transient information in it that you would like to keep 
from drifting, you should use the Polyphonic or Rhythmic algorithms.

Displayed timebase is incorrect after importing Elastic Audio tracks (PTSW-46897)

The incorrect timebase is displayed after importing Elastic Audio tracks to existing tracks with opposite timebase. You will need to man-
ually select the correct timebase for the affected tracks.

Elastic Audio clips on Playlist lanes are not rendered (PTSW-47311)

In Playlists View, any Elastic Audio clips on Playlist lanes are not rendered (waveform is “off-line”) when changing the track’s Elastic 
Audio processing from Real-Time to Rendered. Using the object grabber to select any off-line clips, promoting them to the main playlist 
or copying and pasting the clips in place will render using the selected Elastic Audio algorithm.

Cannot import Elastic Audio tracks with the Consolidate From Source Media option (PTSW-33894)

Use Copy from Source Media to import Elastic Audio tracks. 
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Track Commit and Track Freeze

Frozen Tracks are opened in a partially frozen state in certain versions of Pro Tools 12 (PT-208260)

Opening sessions created in Pro Tools 12.4 or higher that have frozen tracks in Pro Tools 12.0 to 12.2.1 will result in graphical issues 
for “frozen” clips (such as waveforms overlaying clip boundaries, missing clip boundaries, or clip boundaries that move without wave-
forms), tracks and inserts (inserts can be in an inactive/frozen state and cannot be activated). In versions of Pro Tools 11.3.2 and earlier, 
or Pro Tools 12.3, these problems do not occur and the track is opened in it's unfrozen state.

Relinking to missing rendered “frozen” Auxiliary Input tracks does not yield any results when reopening a session (PT-210026)

If there is missing rendered audio from frozen Auxiliary Input tracks, they cannot be relinked after first time of reopening a session. Task 
Manager will report: “Some Files to relink Not Found.” To correct this issue, close and reopen the session, and try to relink to the miss-
ing files again.

Frozen tracks are not translated by AAF and Interplay unless committed (PT-210128)

Only the unprocessed source audio on frozen tracks is translated by AAF and Interplay To ensure that the desired track audio processing 
is translated accurately for AAF sequences (and Avid Interplay), commit those tracks rather than freeze them.

Committing clips on Instrument tracks by dragging them to audio tracks with the Downmixer plug-in may render an incomplete 
clip (PT-207317)

Committing MIDI clips on Instrument tracks by dragging them to audio tracks with Downmixer may render an incomplete clip. Using 
the Grabber tool on these incomplete clips may not function over the incomplete areas of the clip. To avoid this issue, Commit Instru-
ment track clips to new Audio tracks before inserting the Downmixer plug-in.

When committing from two or more Instrument tracks in a session with tempo changes by dragging and dropping to audio 
tracks, and where the Instrument tracks include a mix of sample-based and tick-based tracks, the tick based committed clip is 
trimmed to match the source MIDI original duration even though the audio committed from tick-based MIDI follows the tempo 
changes (PT-208300)

To avoid this issue, use the Trim tool to reveal the rest of the committed audio or commit sample-based MIDI clips and tick-based clips 
separately.

MIDI

Clip Gain and Clip Effects are ignored when converting audio to MIDI by drag and drop from the Clip List. (PT-266337)

If an audio clip on the timeline includes Clip Gain and/or Clip Effects, dragging the same clip from the Clip List to a MIDI or Instrument 
track ignores Clip Gain and/or Clip Effects when the MIDI data is extracted. To include Clip Gain and/or Clip Effects when the MIDI 
data is extracted, drag and drop the audio clip from the audio track instead of the Clip List.

Score Editor is illegible with hundreds of MIDI tracks are in a session. (PT-250083)

Avoid opening the Score Editor when there are hundreds of MIDI tracks in your session. The Score Editor will be illegible when opened 
with many tracks in a session and the showing and hiding of tracks may result in Pro Tools freezing.

Closing a session takes an excessive amount of time when hundreds of MIDI tracks are shown in the Score Editor. (PT-250084)

Avoid opening the Score Editor if you have hundreds of MIDI or Instrument tracks in a session as Pro Tools may quit unexpectedly or 
may freeze (and may need to force quit). If the Score Editor is successfully opened with hundreds of MIDI tracks, closing session will 
take an inordinate amount of time (however a progress bar will be shown). 

Pro Tools does not recognize a MIDI device that is connected or powered on while Pro Tools is running (PT-210853)

Pro Tools does not recognize a MIDI device that is connected or powered on while Pro Tools is running. Quit and relaunch Pro Tools 
for the MIDI device to be recognized. All MIDI devices should be connected and turned on before launching Pro Tools.
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When playing an Instrument plug-in using a MIDI controller and recording the MIDI performance and while also bus recording 
the audio output of that plug-in, the recorded MIDI plays back earlier than the recorded audio (PT-201867)

When playing an Instrument plug-in using a MIDI controller, and both recording the MIDI performance and bus recording the audio 
output of the plug-in, the recorded MIDI performance plays back earlier than the recorded audio. This issue can occur when using Pro 
Tools | HDX with Delay Compensation enabled. You can avoid this issue by switching the Playback Engine from HDX to CoreAudio. 
Once you have recorded your MIDI performance and the audio output from the Instrument plug-in, you can switch the Playback Engine 
back to HDX.

Versions of Sibelius lower than 7.5 do not launch when using the Send to Sibelius command (PTSW-24193, SIB-164)

When you first install any of the supported Sibelius packages (Sibelius, Sibelius First, or Sibelius Student), the Send to Sibelius com-
mand in Pro Tools will return a false error stating that Sibelius is not installed in the system. To avoid this problem, launch Sibelius man-
ually and create a score document. This will only needs to be done once, after which the Send to Sibelius command should function 
properly.

When using Import Session Data on a MIDI track with Real-Time Properties enabled and set to using diatonic transposition, 
transposition is based on the first key signature in the session only (PTSW-49297)

When importing session data from a session that includes multiple key signatures and a MIDI or Instrument track with the “Transpose 
in Key” Real-Time property enabled, the transposition will be based only on the first key in the session. This can be corrected by tog-
gling the Real-Time Properties off and on, at which point the diatonic transposition will be correct for each key.

Unavailable MIDI input paths for MIDI and Instrument tracks are not indicated (PTSW-46839)

The device or path name for MIDI Input on MIDI and Instrument tracks is not italicized and grayed out when opening a session on a 
system where the device or path are not actually present.

Plug-Ins

Plug-ins cannot be instantiated once the maximum number of voices are used. (PT-272796)

Once the maximum number of voices have been used, plug-ins can no longer be inserted on tracks. To be able to insert plug-ins, reduce 
voice usage (such as by making some tracks inactive). Once voice usage is reduced from the maxim limit, you can once again insert 
plug-ins. 

Audible “blip” when opening session that contain bypassed native Signal Generator plug-in. (PT-269830)

When opening session that contain a bypassed native Signal Generator plug-in, a momentary audible “blip” occurs. This issue only oc-
curs on Native systems. This issue does not occur with Pro Tools | HDX systems.

Signal generator plug-in is not bypassed for a moment when duplicating a track. (PT-268663)

A short, audible pop may occur in monitors when duplicating a muted track with Signal Generator plug-in. To avoid this, inactivate the 
track before duplicating it.

Purchasing and installing a newer version of an already installed plug-in may cause a system restart (PT-201687)

If you use the In-Application Plug-in Marketplace to purchase and install a plug-in that is already installed on your system, your com-
puter may restart during installation. This only occurs if the currently installed version is older than the version you just purchased and 
downloaded. If you want to buy an additional license for a plug-in you already own please do so at https://shop.avid.com. If you want 
to install the latest version of a plug-in that you already own, please visit https://account.avid.com/subscriptions or 
https://www.avid.com/plugins; find the version of the plug-in you want, and then download and install it.

For known issues about specific plug-ins, see the Audio Plug-ins Read Me.

https://account.avid.com/subscriptions
https://www.avid.com/plugins
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Using Plug & Mix plug-ins after a DSP insert on HDX systems can result in Pro Tools quitting unexpectedly or freezing, and 
offline Bounce issues. (PT-250123)

Inserting Plug & Mix Native plug-ins after a DSP insert can result in Pro Tools quitting unexpectedly. It is recommended that use Plug 
& Mix plug-ins only before any DSP insert on a track. If your session already has a DSP plug-in preceding Plug & Mix Native insert, 
remove Native Plug & Mix plug-in first and then switch the order of inserts to avoid this issue. It is a known issue that Offline Bounce 
will fail if Plug & Mix plug-ins are preceded by DSP inserts on one or more tracks. In this case, use Online Bounce to Disc.

After updating to Pro Tools 12.8.x or higher, for installed plug-ins that support 7.x.x and Ambisonics channel formats these 
channel formats are not available from the insert selector (PT-230540)

If 7.x.x and Ambisonics formats for installed plug-ins that support these formats are not available from the insert selector after updating 
to Pro Tools 12.8.x or higher, uninstall the plug-in, launch and quit Pro Tools, and then re-install the plug-in. The next time you launch 
Pro Tools, the plug-ins should be available in all supported channel formats.

Pro Tools quits unexpectedly when opening any Facebook Audio 360 plug-in after installing the FB360 video player while 
connected over remote desktop (PT-233584)

To avoid this issue, do not operated sessions with Facebook Audio 360 plug-ins over a remote desktop connection.

The inputs of tracks fed by plug-in Auxiliary Output Sends may become unassigned if the plug-in is recalled as a Track Preset 
on another track (PT-237401)

If a track containing a plug-in feeding other tracks using Auxiliary Output Sends (AOS) is saved as a Track Preset, recalling that Track 
Preset elsewhere in a Session or Project may interfere with the routing of the tracks being fed by the original instance of the plug-in. It 
is recommended that Track Presets containing plug-ins with AOS assignments either be avoided or created in with “Plug-in Assign-
ments” unchecked in the “Track Data to Recall” dialog.

Internally bused tracks from an AOS plug-in are missing from offline bounce. (PT-273158)

(HDX Classic Only)

Internally bussed tracks with outputs from multichannel plug-ins (such as AOS plug-ins) assigned to their inputs will be missing when 
performing an off-line bounce. Use real-time bounce to ensure that these tracks are included in the bounce.

With a plug-in with Auxiliary Output Sends is inserted after a hardware insert on a non-DSP Mode enabled track, AOS output 
signal may be offset by the amount of the System Delay (PT-273287)

(HDX Hybrid Engine Only)

With the HDX Hybrid Engine or Pro Tools | Carbon, audio signal may be offset by the amount of the system delay on AOS plug-in out-
put if there is a hardware insert before the plug-in on non-DSP tracks. To avoid this issue, insert any AAX plug-in between the hardware 
insert and the AOS plug-in.

Using the DSP version of the Pro Multiband Splitter plug-in results in signal loss when routed to an Auxiliary Input track with 
a Native plug-in inserted (PT-272192)

(HDX Classic Only)

When using the DSP version of the Pro Multiband Splitter plug-in on a stereo audio track with one of its Auxiliary Output Sends routed 
to a stereo Auxiliary Input track with a Native plug-in inserted, audio may not pass. To avoid this issue, use a DSP version of the plug-
in on the stereo Auxiliary Input track.

It is not possible to recall an insert from a Track preset that contains third-party multichannel plugins on a track of a smaller 
channel width than that from which the preset was created. (PT-236149)

When attempting to recall an insert from a Track preset that contains third-party multichannel plugins on a track of a smaller channel 
width than that from which the preset was created, Pro Tools does not load the preset. Instead, you are presented with a warning message 
stating that “Pro Tools cannot convert the following multichannel plug-ins that were originally saved in this track preset to the format 
of the current track. The original format of the track was “X”.” If you encounter this issue, create an instance of the Track preset for each 
needed stem format. Also, note that if an insert from a mono Track preset is recalled on a multichannel track, any third-party plug-ins 
are converted to multi-mono instead of remaining multichannel. This is only an issue with certain third-party plug-ins.
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AudioSuite and Clip Groups (PTSW-57457)

AudioSuite plug-ins handle Clip Groups in the Clip List slightly differently than audio files. With audio files, an AudioSuite process can 
be applied to all copies of a unique audio file which appear in your session by selecting your target as Clip List in the AudioSuite plug-
in window and selecting Use in Playlist. However, if your target is set to Clip List in the AudioSuite plug-in window while you have a 
Clip Group selected, Pro Tools does not recognize the Clip Group as processable audio and will present a No Audio was Selected error. 
This is because a clip group is not treated as audio until it is actually used in a track.

To apply an AudioSuite process to all copies of a Clip Group in a session at once, do the following:

1 Select the Clip Group to be processed.

2 From the Clip List menu, select Ungroup All. All elements of the group will remain selected.

3 Perform AudioSuite processing.

4 From the Clip List menu, select Regroup.

5 When prompted, select Modify to apply the AudioSuite Process to all copies of the Clip Group in the session, or Copy to apply it only 
to the selected Clip Group.

Plug-In Find and Relink with file types not supported by Pro Tools (111704)

Find and Relink will not be triggered by plug-ins in situations where plug-ins are missing links to file types that are not natively sup-
ported by Pro Tools (such as REX files). To have full Plug-in Find and Relink support, the file types used by plug-ins must also be sup-
ported by Pro Tools.

MIDI outputs to some software synthesizer plug-ins are italicized in cross-platform sessions (PTSW-33965)

With some software synthesizers, MIDI output ports show up italicized when opening a session on a different computer platform than 
the session was created on until you re-assign the outputs.

When replacing one plug-in with another, the new plug-in inherits previously auto-enabled parameters (PT-202826)

With the Plug-in Controls Default to Auto-Enabled preference enabled, all available automation parameters become unexpectedly re-en-
abled (merged) after replacing one instance of the plug-in with another. Disable this preference before replacing one plug-in with an-
other to avoid this issue.

Some plug-in automation may be delayed on playback. (PT-262935)

At some sample rates and hardware buffer size configurations, plug-in automation may play back out of time. If you encounter this is-
sue, you may be able to correct this issue by increasing the HW Buffer Size in the Playback Engine.

Clip effects may be rendered when rendering clip gain (PT-218043)

When rendering clip gain for a clip, any active clip effects may also be rendered. To avoid unintentionally rendering clip effects, bypass 
clip effects for the clip before rendering clip gain.

DSP Mode
(HDX Hybrid Engine Only)

Pro Tools does not report a lack of output channels when a Hardware Insert is instantiated on any audio track in the session. 
(PT-273811)

Pro Tools does not report a lack of output channels after enabling DSP Mode on all audio tracks when a Hardware Insert is instantiated 
on any audio track in the session. In this case, the output of out-of-resource tracks appears active. Reassign the output of the track with 
the Hardware Insert or move the Hardware Insert to the insert above (for example, from slot b to slot a), and the warning dialog appears 
and the outputs of the out-of-resource tracks to appear inactive. Also, note that if a Hardware Insert is instantiated on an out-of-resource 
track, the track remains unvoiced even after disabling DSP Mode on the track. 
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InputMonitoring incorrectly enabled on some tracks. (PT-274120)

In sessions that use all the available Hybrid Output channels, enabling InputMonitoring on a track may incorrectly cause InputMoni-
toring to be enabled on other tracks as well. To avoid this issue, toggle the InputMonitor button on tracks with InputMonitoring incor-
rectly enabled.

When a DSP Mode–enabled track is routed to any subpath of a multichannel path, DSP Mode is automatically enabled for all 
tracks that use that multichannel path or any of its subpaths. (PT-272552)

Enabling DSP Mode on a track that is routed to any subpath of a multichannel path automatically enables DSP Mode on all tracks that 
use that multichannel path or any of its subpaths. Enable DSP Mode Safe on any affected tracks that you do not want in DSP Mode.

Native to DSP cascade bus recording over mono subpaths early by 3–5 samples depending on sample rate. (PT-273251)

When cascade bus recording over mono subpaths to DSP Mode–enabled tracks from a source track that is not in DSP Mode, the re-
corded audio may start early by 3–5 samples depending on the sample rate. To avoid this issue, do not use mono subpaths with cascade 
routing or enable DSP Mode on the source track.

Playback signal delayed on a record-enabled audio track in DSP Mode with a Send to Auxiliary Input track. (PT-274282)

In a session that combines tracks with DSP and Native plug-ins, the playback signal may be delayed by the amount of the System Delay 
on a record-enabled track in DSP Mode that has a Send or additional output routed to Auxiliary Input track. To avoid this issue, either 
disable Delay Compensation on the Auxiliary Input track or enable DSP Mode Safe on the Auxiliary Input track.

Sound artifacts present while disabling DSP Mode for a source track in an internal buss connection. (PT-271985)

When a DSP Mode–enabled source track is bussed to another DSP Mode–enabled track with input monitoring, and then DSP Mode is 
disabled for the source track, a buzz can be heard on input-monitored track’s output. To avoid this issue, deactivate InputMonitoring on 
the destination track prior to disabling DSP Mode on the source track.

With Delay Compensation disabled, bus recording is offset on Native tracks. (PT-274329)

With Delay Compensation disabled, bus recording is delayed on Native tracks by 2,048–8,192 samples depending on the session sample 
rate. To minimize the offset, record to DSP Mode–enabled tracks.

When using Track Punch and Destructive Punch modes, audio recorded from live input through an Auxiliary Input track and 
then bussed to audio track is offset by system delay amount. (PT-274486)

When using Track Punch and Destructive Punch modes, audio recorded from live input through an Auxiliary Input track and then 
bussed to audio track is offset by system delay amount. To avoid this issue, use Quick Punch, Loop Record, Destructive Record, or nor-
mal record modes instead.

Streaming Errors at Low Buffer Sizes with oversampling enabled in plug-ins. (PT-274324)

When using lower buffer sizes with plug-ins that offer Oversampling, you may experience streaming errors. If you encounter this issue, 
disabling Oversampling in these plug-ins may improve streaming performance.

After enabling DSP Mode on a track with Wholegrain Trio DynPEQ and Quartet DynPEQ plug-ins, Pro Tools quits unexpectedly. 
(PT-273231)

After enabling DSP Mode on a track with Wholegrain Trio DynPEQ and Quartet DynPEQ plug-ins, Pro Tools quits unexpectedly. To 
avoid this issue, enable DSP Mode Safe for the track and use the Native versions of these plug-ins.

HDX Systems

AAE –1103 errors on Windows when swapping a chassis with Avid Audio PCI-e cards between multiple systems. (PT-246977)

If you swap a PCI-e chassis with Avid audio cards between multiple systems, you may encounter AAE –1103 errors on a Windows 
based systems. To avoid this issue, reboot your computer with the chassis connected.
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Installing HDX Firmware reset can result in a Kernel Panic or Blue Screen if more than one card is reset in quick succession. 
(PT-247759)

If an HDX firmware update fails and you reset your hardware to factory default to try again, you may find that attempting to reset more 
than one card at a time can result in a kernel panic on macOS or a blue screen error on Windows. If you encounter this issue, reset the 
firmware on one card at a time. Launch Pro Tools to install the latest firmware on one card, then shutdown and repeat the process on 
each additional card in the system.

If a DigiReWire client is open when a firmware downgrade is requested, a “Pro Tools quit unexpectedly” warning is displayed 
after quitting Pro Tools. (PT-247346)

If a DigiReWire client (such as Reason or Live) is open when an HDX firmware downgrade is performed, Pro Tools may not quit cor-
rectly. This dialog can safely be ignored. Should you need to upgrade and downgrade your HDX firmware regularly, avoid having a Di-
giReWire client open when doing so.

Pro Tools does not play back when an invalid sync source is selected on SYNC HD (Word Clock or AES/EBU) (PTSW-156651)

When attempting to initiate playback, playback will fail if a SYNC HD is connected to an HDX card and an Avid audio interface with 
no connections to either the word clock or AES/EBU ports. Ensure that the clock is set to a working clock source to resolve this issue.

In Avid DigiTest, the reported slot number may not correspond to the physical slot number in the computer (PTSW-155373)

In Avid DigiTest, the slot number reported for HDX cards starts from 0 on up. For example, “Slot 1” does not necessarily correlate to 
the first physical slot in the machine. If you have an HDX card that is having problems, match the Serial Number ID on the back of the 
card with the Serial Number ID displayed on the Slot Info page in Avid DigiTest.

Audio stops in certain circumstances with multi-card HDX systems (PTSW-158701 and PTSW-157600)

Signal routing issues are known to occur with HDX systems on HP Z800 Workstations. To resolve these issues, run HP Performance 
Advisor software after installing Pro Tools, and load the Avid optimized settings.

Corrupted audio when bus recording or bouncing to disk (PTSW-158063 and PT-202030)

HP Z800 workstations can drop samples while recording or bouncing to disk when an HDX card is present in PCIe Slot #3 (connected 
to the Southbridge). This problem is resolved by updating the HP Z800 to the latest BIOS (3.54) or by installing the card in another PCIe 
slot. Use the HP Performance advisor to update your machine before or after installing your HDX card(s).

Printing interleaved files with more than 8 channels per track on HDX 2 or greater system results in AAE error -9060. (PT-248851)

Printing interleaved files with more than 8 channels per track (such as 7.1.2) on a system with more than one HDX card will fail with 
AAE error –9060. To avoid this issue, print multi-mono files.

HD Native Systems

HD Native cannot be initialized in Device manager after FPGA update (PT-268965)

In some cases HD Native may not be initialized in Device Manager after an FPGA update. For example, when installing Pro Tools on 
a clean system, and then launching Pro Tools and updating HD Native firmware, HD Native may be shown in Device Manager as Other 
Device and may not be available in the Pro Tools Playback Engine. To correct this issue, go to Device Manager > Sound, video and 

game controllers, right-click on HD Native, choose uninstall device (do not choose Delete the driver software for this device), and then 
click Scan for hardware changes. HD Native should now be properly initialized. If that fails, restart your computer after updating HD 
Native firmware instead of shutting down.

“Avid HD Native Thunderbolt device is not certified on a qualified HP Z machine.” (PT-234613)

If you encounter this warning, you may safely allow the connection to your HD Z machine.

The HD Driver may not load properly after a cold boot when using a HD Native Thunderbolt audio interface with a PCIe 
Thunderbolt 2 card. (PT-243053)

Starting up your computer after a full shut down may result in the HD driver not loading properly when using a HD Native Thunderbolt 
audio interface with PCIe Thunderbolt 2 card. Restart your computer to resolve this issue and the HD driver should load correctly.



 Pro Tools and Pro Tools | Ultimate Software 2021.10 on Windows 10 — 10/27/21 23

Audible pops and clicks when changing buffer sizes (PTSW-125715)

Pops and clicks may occur when changing the Hardware Buffer Size (H/W Buffer Size) in the Playback Engine dialog while monitoring 
live audio through HD Native hardware. Avid recommends not changing the Hardware Buffer Size while monitoring live audio to avoid 
this problem. If you must change the Hardware Buffer Size while monitoring live audio, be sure to lower the monitoring volume to avoid 
any possible damage to your speakers.

Control Surfaces

EUCON and Legacy Control Surfaces options cannot both be enabled at the same time. (PT-279360)

In previous versions of Pro Tools, both the EUCON Control Surfaces and Ethernet Control Surfaces options could be enabled at the same 
time in the Ethernet Controllers page in the Peripherals dialog (Setup > Peripherals). However, having both options enabled simulta-
neously could cause issues with performance and usability. The Ethernet Control Surfaces option has been renamed as Legacy Control 

Surfaces, and now the EUCON Control Surfaces option and the Legacy Control Surfaces option are mutually exclusive. If one option 
is enabled, it is disabled when enabling the other option. Consequently, EUCON control surfaces (such as S6 or S1) and Legacy Ethernet 
control surfaces (such as D-Command or Cl|24) cannot be used at the same time on a single system, but issues that occurred previously 
are avoided.

Improper selection response for Input type and Link controls on S1 surface with Avid PRE Mic Preamp controls (PT-278737)

When running Pro Tools with an S1 control surface connected over EUCON and Avid PRE hardware, and with the Preamp Control set-
tings displayed on S1 surface, the Input Type and Link controls behave improperly. For example, when changing the Input source from 
Mic to Line, the display should show Line while you are touching the knob, but instead changes from Mic to Inpt Type and then stops 
responding further until you touch it again. Link control behaves similarly. To work around this issue, re-touch the knob each time you 
want to change either of these settings.

Mic Preamp controls disappear unexpectedly from S6 Knob and Display Modules (PT-278363 and PT-278682)

Mic Preamp controls for Avid PRE may become unavailable with the S6 Knob and Display modules after performing certain operations, 
such as creating new tracks in Pro Tools or selecting Input Types from the associated modules. The display can usually be restored by 
switching to a different view on the affected S6 channel strip (such as EQ) and then switching back to Input, or in some cases re-select-
ing the affected track’s input in Pro Tools.

S6 Automation Module does not fully populate with Pro Tools 2018.1 or later launched. (PT-236983)

In order to see the icons populate on the Master Module when using Pro Tools 2018.1 or later with S6 3.6.1 or 3.7, update to S6 2018.3 
software or later.

Performance issues may occur when using EuControl with the H/W Buffer Size set to 32 in large sessions on macOs. 
(PT-248711)

Working with large sessions with the H/W Buffer Size set to 32, and with EUCON enabled, may result in CPU spikes and AAE –6101 
errors during playback. If your session exceeds 500 audio tracks it is recommended that you use H/W Buffer Size of 64 or larger when 
EUCON is enabled.

Trim Scrub and Trim Shuttle don’t work on clips with fades (PTSW-46911)

If a clip has fades, Trim Scrub and Trim Shuttle don’t work when trying to trim using a control surface. To work around this problem, 
remove any fades on the clip, then execute the Trim Scrub or Trim Shuttle, and then restore the fades.

Used HW output path indication (PTSW-17559)

In Assign Matrix, Insert mode the used HW output path will not have amber background indicating that it's already assigned after 
switching to a different insert on the same track.

Color indication on plug-in controls in Learn mode (PTSW-18480)

When a plug-in is in Learn mode and the track with this plug-in is not focused on the main ICON unit, all automation LEDs in the 
plug-in window will be red if the track is in one of auto write modes. This conflicts with red color indication on the plug-in control, 
which is armed for mapping. The workaround is to set the track with plug-ins to Read automation mode.
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Send/Pan mode on D-Command for Sends F–J (PTSW-50046)

In Pro Tools 7.3 and higher, if you save a session on D-Command which is in Send/Pan mode for Sends F-J, the session will open in 
previous versions of Pro Tools with the channel fader controlling that Send level, as if in Flip mode. To avoid this, open the same session 
in Pro Tools 7.4, take the session out of Send/Pan mode, and re-save the session.

SignalTools meter ballistics on control surfaces (PTSW-52799)

SignalTools RMS, VU, BBC, Nordic and DIN meters will display inaccurate decay times when viewed on a control surface. Unaffected 
types are Peak, VENUE, and Peak + RMS, which only reports the Peak meter to the control surface. The attack times of the affected me-
ters are not affected, only the decay times. All meter types display accurately in the plug-in window.

Channel Strip plug-in Expander/Gate meters appear in the Compressor/Limiter meter instead of in the Expander/Gate meter in 
D-Control Dynamics section (Main Unit) (PTSW-150897)

The Avid Channel Strip plug-in uses shared meters for Expander/Gate and Compressor/Limiter processing. Because of this, both Ex-
pander/Gate and Compressor/Limiter metering appear only in the Compressor/Limiter meter in D-Control Dynamics Section (Main 
Unit).

D-Control and D-Command timecode counter does not display first hours digit with a greater than 100 fps timeline (PT-253045)

If the session timecode rate is over 100 fps, the first hours digit will be truncated on the ICON timecode counter (though it can still be 
viewed on the main counter in Pro Tools). This is a hardware limitation because the ICON counter only contains 8 digits whereas 9 digits 
would be required to display all possible frame values.

The Edit and Mix windows do not follow banking on EUCON control surfaces (PTSW-133466)

When the Edit Window Follows Bank Selection and/or the Mix Window Follows Bank Selection preferences are enabled in Pro Tools 
(Setup > Preferences > Mixing), after banking your EUCON controller, neither the Edit nor Mix window scroll to follow. You will have 
to manually change the view of the Edit or Mix windows to see the tracks that correspond to the EUCON controller if they are off screen.

Video

Video Engine crashes when bouncing DNxHD SQ material Same as Source with blank space included in selection. (UME-1587)

When bouncing DNxHD SQ material (such as DNxHD 80 at 1080p24) to QuickTime using Same as Source, the Video Engine displays 
an assertion if an area of blank space is included in the bounce selection. To avoid this, do one of the following: do not select any blank 
space, do not choose Same as Source in Bounce Settings, add black video to the blank space before bouncing, or use a different DNxHD 
bit rate as source material. 

Same as Source Bounce to QuickTime is not possible with ProRes, H.264, or PJPEG source media if the timeline selection 
contains blank space. (UME-1582, UME-1583)

If blank space is included in the timeline selection, and the source video codec is Apple ProRes, H.264, or PJPEG, then Same as Source 
QuickTime export is not be permitted. If it is necessary to bounce Same as Source, either use DNx source material or replace any blank 
space with black frames before bouncing. Note that bouncing from ProRes to ProRes is possible by adjusting the QuickTime Settings 
in the QuickTime Bounce dialog. 

ProRes files are sometimes re-encoded instead of copied during Same as Source MOV bounce. (PT-273601)

When performing a Same as Source bounce to MO, Pro Tools may re-encode Apple ProRes media instead of copying the essence of the 
original file. If this occurs, the bounce takes longer than expected but should complete without any other problems. 

QuickTime movies with MP3 encoded audio cannot be imported. (PT-266982)

It is not possible to import video from a QuickTime file that contains MP3 encoded audio. In order to import the audio from one of these 
files, use the Import Audio command.
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Audio from a QuickTime movie imports in the wrong channel order. (PT-265173, PT-265173, PT-266358, and PT-266834)

Pro Tools 2020.11 (and higher) uses QuickTime channel descriptor metadata when importing audio from a QuickTime file. This is used 
to place audio channels on the timeline in the correct order. Pro Tools always places audio channels on the timeline in Film order 
(L C R Ls Rs LFE), regardless of the physical channel order in the file. If a QuickTime file does not contain channel descriptor metadata, 
the file will be assumed to be in SMPTE order (L R C LFE Ls Rs).

Pro Tools 2020.9.1 (and earlier) exports QuickTime files in Film order, but it put channel descriptors in SMPTE order. Pro Tools 
2020.9.1 (and earlier) does not respect channel descriptors and assumes files are in Film order. As a result, channel orders are incorrect 
when importing QuickTime files generated between 2020.11 and 2020.9.1. 

Video fails to import with multiple codecs in a single file. (UME-1580)

A missing codec error may be encountered when importing a QuickTime video that contains multiple codecs in a single file. To avoid 
this issue, use different files for each codec.

Video clips in the AAF are in the wrong timeline location (PT-258888)

Video clips on the timeline will not be in the correct location if there are any other unrendered video clips included in the sequence. To 
avoid this issue, make sure that the AAF has all video rendered upon export from Media Composer.

Pro Tools quits unexpectedly on launch if ASIO4All is installed, and a Blackmagic or Avid video peripheral is present and 
enabled in Windows Device Manager (PT-244170 and BMD-352)

Pro Tools will not launch if both ASIO4ALL and a Blackmagic video peripheral, or Avid Artist DNxIQ or DNxIO is installed. The 
launch fails immediately with no error. To avoid this issue, disable the “Avid Artist <device name> AVStream” or “Blackmagic <device 
name> AVStream” driver found under the “Sound, video and game controllers” heading of the Windows Device Manager. With this 
disabled, Pro Tools will launch and the video hardware will still function.

Mojo/Nitris DX will not lock to the expected video reference if other formats are imported after 1080p23. (PT-255575)

If importing a 1080p23 file, followed by an interlaced file, followed by another 1080p23 file, Mojo and Nitris DX will only lock to 
1080i47 video reference instead of 1080p23. This can be resolved by quitting and relaunching Pro Tools.

No picture is seen with Avid Mojo or Nitris Dx video peripherals when using non-standard size video rasters. (PT-255951)

Some video files with non-standard video raster sizes will not display properly with the Avid Mojo or Nitris Dx video peripherals. If you 
encounter this issue, try setting the engine Raster Size to a different, standard size (in the I/O section of the video track).

Video appears squished during playback on the video hardware display when using 720x486 or 720x586 raster sizes with 
certain frame rates. (PT-256019)

When using 720x486 with 23 or 24 fps, or when using 720x586 with 24 or 25 (progressive) fps, video output may display squished 
during playback on the hardware display. To avoid this issue, try setting the engine Raster Size (in the I/O section of the video track) 
to an HD raster size (such as 1080x1920).

SD video will not stretch to a 16:9 aspect ratio on the desktop display. (UME-1529)

When using 720x486 and 720x586 raster sizes, and the aspect ratio is set to 16:9 with the Stretch setting enabled, the video window size 
updates to 16:9, but the picture does not stretch. You can workaround this by setting the engine Raster Size to an HD raster, such as 
1920x1080. This can be done by Command-clicking (Mac) or Control-clicking (Windows) on the engine Raster Selector (in the I/O sec-
tion of the video track).

DNxIP automatically displays 2Kp50, 2Kp59.94, or 2Kp60 video as 1080p when outputting through the HDMI or SDI 
connections. (PT-252007)

DNxIP only outputs 2Kp50, 2Kp59/94, and 2Kp60 video over IP using the SMPTE 2110 standard. The HDMI and SDI outputs will not 
display these formats. Instead, DNxIP switches to 1080p in order to maintain the higher frame rate. Additionally, you must have in-
stalled the latest firmware update that is included with the driver. Visit www.avid.com for the latest driver compatibility information.

http://www.avid.com
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Playback of QuickTime video in Pro Tools may stutter or drop frames

When monitoring QuickTime playback in the Pro Tools Video Window on the computer screen, the video image may stutter or drop 
frames. To improve results with QuickTime playback, try any of the following:

• Disable Continuous Scrolling.

• Close unnecessary UI windows.

• Try using the DNxHD codec.

• A second Pro Tools or Media Composer Video Satellite option offers guaranteed performance for Avid video playback with a primary 
HDX or HD Native system.

Unsupported QuickTime video formats (PTSW-52140, PTSW-52155, PTSW-52157)

Several video formats supported in QuickTime are not supported in Pro Tools. These include .DivX, .flc, .m4v and .3gp format movies. 
Attempting to import these will generate errors or will fail to import.

QuickTime files that contain multiple CODECs may not import (UME-835)

If the Pro Tools tells you that a file cannot be imported because it may be unsupported, check to see if the file contains more than one 
CODEC. This can be done by opening the file in QuickTime player and examining the file properties. QuickTime files that contain more 
than one CODEC are not officially supported for import into Pro Tools.

1080p50 AVC-Intra100 causes an “The Avid Video Engine stopped unexpectedly” error. (PT-255898)

1080p50 AVC-Intra100 QuickTime media causes an “The Avid Video Engine stopped unexpectedly” error. To avoid this issue, use an-
other application to transcode the media to another codec, such as DNxHD.

1080p50 XDCAM 50MBPS will not draw thumbnails or display picture. (UME-1459)

1080p50 XDCAM 50MBPS QuickTime media will not draw thumbnails, and the video window displays black. To avoid this, use an-
other application to transcode the media to another codec, such as DNxHD or H.264.

1080p50 video can only be bounced as “Same as Source” (PT-236136 and PT-235110)

Pro Tools can only bounce 1080p50 video using the “Same as Source” method. Transcode is not allowed at this time. If you would like 
to change the codec or attributes of the exported video, use another application.

“No valid same as source resolution found” when bouncing DNxHR MXF files as Same As Source. (UME-1529)

DNxHR MXF files cannot be bounced using Same as Source at this time. Instead, it is possible to re-transcode the bounced file to Quick-
Time DNxHR, or you can use DNxHR QuickTime in your workflows to utilize the Same as Source bounce option with DNxHR media.

Pro Tools presents the following error: “The Video Engine has reported an error. More information is in the Video Engine log 
file” when attempting to play back video files with a resolution of 1080p50 using the AVC-Intra100 and 200 CODECs. (UME-1394) 

Pro Tools cannot play back video files with a resolution of 1080p50 using the AVC-Intra100 and 200 CODECs. Doing so results in the 
following error: “The Video Engine has reported an error. More information is in the Video Engine log file.” There is currently no work-
around for this issue, so you must transcode the media to another CODEC, such as DNxHR or Apple Pro Res.

Video media using XDCAM CODECs displays only black in a 1080p50 video project type. (UME-1392)

XDCAM codecs display only black when using a 1080p50 project type. There is currently no workaround. Transcode the media to an-
other CODEC, such as DNxHR or Apple Pro Res for use with Pro Tools.

Closing the QuickTime window during session playback may result in –9092 errors that stop playback (PTSW-162502)

To avoid this issue, try increasing the number of CPU Cores available for Pro Tools processing and/or raise the H/W Buffer Size in the 
Pro Tools Playback Engine dialog.

“Error reading video in the QuickTime files” when importing some MPEG 1 and 2 video files in Pro Tools (PTSW-178017)

Some MPEG1 and MPEG2 files cannot be opened by Avid applications, including Pro Tools. Transcode these files to one of our pri-
mary CODEC such as DNxHD or AppleProRes for use in Pro Tools to avoid this issue.
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MPEG-1 and MPEG-2 video freezes at edit points (79182)

Editing MPEG-1 & MPEG-2 video is not officially supported. If you experience this problem, try switching playback to the Video win-
dow, or convert the movie to a supported format using a 3rd party application. Removing the audio from an MPEG-1 or MPEG-2 movie 
with a 3rd party application may also fix the problem.

3G2 file extension is not supported for video import (PTSW-178015)

Pro Tools 11 provides support for the .3GP file type extension for video import. These are video files often created on mobile phones. 
The second generation of this format uses the file extension of .3G2. Files with the .3G2 file extension will be filtered out as unavailable 
for video import. These .3G2 files may be available for import if their file extension manually changed to .3GP. If the files remain un-
available for import after changing their extension, they will need to be converted to an explicitly supported format such as DNxHD or 
AppleProRes for use in Pro Tools.

Audio and video will not stay in sync when using ASIO4ALL (PTSW-179261)

When ASIO4ALL is selected as the Pro Tools Playback Engine, video may drift out of sync and even drop frames. To avoid this, use 
a supported Avid audio interface.

Video pull factor may become invalid when video hardware is enabled (PTSW-180554)

If a software video pull factor of 0.1% is set while video hardware is disabled, enabling the video hardware may create an illegal pull 
setting. Video hardware only supports 0.1% pull ups at 24pPAL rates, and 0.1% pull downs at 25pPAL rates. If the pull rate is set to 
0.1% at any other rate while video hardware is enabled, manually select an available option from the pull menu, which may be “none.”

Video may not stay in sync when video hardware is attached and Pro Tools is locked to an external clock (PTSW-178722)

If both Pro Tools and an attached video peripheral are each resolved to an external clock, but the clock is not derived from the same 
source, video will not stay in sync. An example of this would be if the video peripheral is locked to black burst, and the audio peripheral 
is locked to an audio clock not derived from the same video black burst, such as SPDIF. In this scenario, setting the video peripheral to 
lock to its own internal clock will allow Pro Tools to compensate for video drift over time.

Video file frame rates may not appear in the Workspace for files with frame rates above 60 fps. (PT-245451)

Video file frame rates may not appear in the Workspace for files with frame rates above 60 fps. If you encounter this, delete the Work-
space.wksp database file to correct this issue.

Third-Party Video Peripherals

The following issues may occur with third-party video hardware. Please contact your hardware vendor for support.

 In some cases, video will not stay in sync over time if the video peripheral is not, or cannot, lock to video reference. If you experience 
this, a workaround is to set the Pro Tools clock to internal. This will cause the video peripheral to slew overtime and stay in sync with 
Pro Tools. (THPV-2)

 With some peripherals video playback will be one frame out of sync with Pro Tools audio. To compensate for this, choose Setup > 

Video Sync Offset and enter a 1 frame offset. (THPV-9)

 With some video peripherals, the video output will be scrambled when video is not loaded in Pro Tools, or when the video peripheral 
is disabled. (THPV-32)

Video Satellite

Playback and locate offsets may be seen when working with a Media Composer Video Satellite that has a 119.88 fps timeline. 
(PT-255060)

A timeline offset of about 30 seconds will be seen when working with a Media Composer Video Satellite that has a 119.88 fps timeline. 
Check the Video Satellite compatibility page at www.avid.com for the latest support information and known issues.

Mismatched video reference warning with larger than HD rates (PT-233603)

If a Media Composer Video Satellite has a larger than HD Project Type, linking to a Pro Tools Satellite results in an erroneous video 
reference mismatch dialog. Despite the warning, the systems will play in sync.

http://www.avid.com
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Pro Tools and Media Composer Video Satellite Quit Unexpectedly when Disconnecting an Additional Pro Tools System During 
Playback (PTSW-23142)

When multiple Pro Tools systems are connected via Satellite Link in conjunction with a Video Satellite, always stop playback before 
disconnecting any of the systems. 

“Pro Tools Cannot Currently Play” Error (Item # UDevC00116083)

In a Video Satellite configuration, when the system is sitting idle, Media Composer may post the dialog, “Pro Tools cannot currently 
play, is online with Machine Control, or is in Transport = Remote Mode. Please resolve the issue with the Pro Tools system and try 
again.” To avoid this problem, link the Video Satellite from the Pro Tools Administrator system rather than from Media Composer.

Media Composer Video Satellite cannot be enabled when Pro Tools is co-installed on the same computer (UME-956)

When Media Composer and Pro Tools are co-installed on the same computer, that system cannot be used as a Video Satellite. To use 
the computer as a Video Satellite, uninstall Pro Tools and re-install Media Composer. 

23.976 or 24 fps Sequence Start Time Ending In Digits Other than “:00” Causes Time Code Offset 

Media Composer uses NTSC or PAL time code when setting the sequence start time regardless of the format selected by the user for 
display. When you are working on a video satellite project at 23.976 or 24 fps, a Media Composer sequence with a start time that ends 
in a value other than :00 causes an offset between Pro Tools and Media Composer at the session start. For example, the start time 
45:02:10:15 (ending in :15) would cause an offset, but the start time 45:02:10:00 (ending in :00) would not.

As a workaround, always set your Media Composer sequence start time to a time code value ending in 00.

Cueing from Media Composer in a 720p Project Causes 1-Frame Offset (Item # 98460)

In 720p projects, Media Composer counts at 50 or 60 (59.94) progressive fps—depending on the project type—while Pro Tools counts 
at 25 or 29.97 frames per second. When you cue a sequence from the video satellite in a 720p project, the Pro Tools edit cursor can be 
offset by as much as one frame. 

As a workaround, cue and play back from Pro Tools when working with a 720p project in a video satellite system. This ensures that the 
two applications are always in sync. It is not possible to cue to odd 50 or 60 frame boundaries (for example, frame 47) from Pro Tools.

Audio and video may drift out of sync In Satellite Mode in certain conditions (Items # UDevC00090064, UDevC00090078, 
UDevC00088666, UDevC00089437, UDevC00087542)

When operating in Satellite mode, audio and video output from Media Composer may drift out of sync by as much as one frame in any 
of the following conditions:

• When viewing video full screen in 1394 mode. This is due to the difference between the monitor's refresh rate and the video reference 
rate.

• When the Edit Play Rate of the video differs from the frame rate of the video reference signal. (For example, this occurs with a 24p 
NTSC project with 23.976 Edit Play Rate and NTSC reference signal.)

• When looping a selection that is not aligned to video frame boundaries in Pro Tools. As a workaround, make your selection in 
Pro Tools using Grid mode with the Grid value set to 1-frame increments—especially when it is necessary to loop several times with-
out stopping.

Pro Tools Satellite Systems

Saving logs only saves logs for linked satellite systems. (PT-248378)

It is possible to gather log files across a set of Satellite Linked systems. This can be done by going to Setup > Preferences > Operation, 
and clicking Save Logs button. When this is done, it will zip the needed logs on each of the satellite systems, but it will not zip the logs 
on the system that executed the Save command. To gather logs on that system you need to unlink satellites and save the logs again. Sav-
ing logs only needs to be done when instructed to do so by Avid Customer Care.
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Synchronization and Machine Control

When updating Sync X or SYNC HD firmware, DigiTest defaults to the wrong card with more than one HDX card installed. 
(PT-261032)

DigiTest may default to second or third installed HDX card rather than lead. When using DigiTest to update Sync X or SYNC HD firm-
ware, you will need to select the right card before the firmware upgrade can be successfully run.

With Sync X or SYNC HD at 176.4 kHz and 192 kHz, higher VSO values are selectable but cannot play. (PT-267639 and PT-267637)

With Sync X or SYNC HD at 192k, the VSO Up range is only about .2 semitones even though greater values can be selected. At 
176.4 kHz, playback of positive VSO values are limited to +1.67 or less.

While Video Ref Source is Sync X, enabling or disabling Generate LTC causes momentary fluctuations in Detected Rate and 
Clock Ref display as the clock resets. Clock Ref may briefly display as unlocked. (PT-266430)

There is currently no workaround for this issue.

Sync X front panel Page 4 – Position Ref displays “Generate” when Serial Timecode is selected for Positional Reference in 
Pro Tools. (PT-259487)

There is currently no workaround for this issue.

Session Setup window does not update when switching from Sync X to Sync HD without quitting Pro Tools. (PT-260473)

If you want to switch between Sync X and Sync HD, quit Pro Tools before making the cabling changes.

Intermittently out of sync when chasing LTC with high frame rate video reference (PT-246213)

Systems that are locked to video reference above 30 fps may experience intermittent sync offsets that can vary between each playback 
pass. These offsets may be a frame or more, depending on the frame rate. To avoid this, lock Pro Tools systems to 30 fps or lower video 
reference whenever locking to LTC or generating LTC that another system may be chasing.

Recording with serial timecode (PTSW-63013, PTSW-60432)

Occasionally, it is possible for the Tascam DA-98 servo lock bit behavior to cause Pro Tools to think the DA-98 is servo locked before 
it actually is. This could cause a synchronization offset when Pro Tools locked to serial timecode generated from a DA-98. Pro Tools 
will now handle these cases, but if you experience this problem, try increasing the amount of frames to 10 in the “Delay before locking 
to Timecode” preference. 

The “Machine Cues Intelligently” preference should not be used with non-linear decks (46200)

Pro Tools overshoots and posts an “Error Cueing Machine” dialog if the Machine Cues Intelligently preference is checked when using 
non-linear playback devices.

Recording is not sample accurate when re-triggering play by clicking into the Timecode ruler of a 9-pin Master without issuing 
a Stop command first. (PT-262678)

Do not click in the Timecode ruler of the Master system to re-trigger play. Either use a 9-pin controller or issue Stop and then Play com-
mands from the Master system.

When using Serial Timecode, if Play is triggered at a timecode location before session start, no audio is output when session 
start is reached. (PTSW-153187)

To avoid this issue, insert time at the session start so that PreRoll does not start before session start.

Dolby Atmos

ADM Export to SMB shared network storage results in an error. (PT-270427

Attempting to bounce a Dolby Atmos ADM BWF file to SMB network shared storaged from a Windows Pro Tools system may result 
in this dialog: “Error was encountered when writing ADM to storage. This might be due to either a slow drive or network storage. The 
bounce will be aborted.” Use other storage as the ADM bounce destination to avoid this issue.
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7.1.2 audio is heard out the incorrect channels (PT-263665)

7.1.2 interleaved files that were created in Pro Tools 2019.6 (and earlier), play audio out incorrect channels if opened in Pro Tools 
2019.10 (or later). Please visit the following knowledge-base article for more details: https://avid.secure.force.com/pkb/articles/
readme/Pro-Tools-7-1-2-Channel-Order-Change.

Dolby Atmos object panning for stereo tracks created in Pro Tools 12.8 or 12.8.1 may sound different in Pro Tools 12.8.2 or 
higher (PT-232805)

In Pro Tools 12.8 and 12.8.1, internal panning is improperly applied to Stereo Objects before the RMU inputs. Pro Tools 12.8.2 and 
higher correctly applies all object panning metadata in the RMU. Consequently, object panning for stereo tracks created in Pro Tools 
12.8 or 12.8.1 may sound different in Pro Tools 12.8.2 or higher. If you encounter this issue, you may need to change the object panning 
automation for stereo tracks.

Cannot map busses to Objects when connected to a VPN (PT-228845)

You can map busses to Objects even when not connected to a Renderer as long as Atmos is enabled in the Peripherals dialog. However, 
you may not be able to map busses to Objects if you are using a Virtual Private Network (VPN). To map busses to Objects when offline, 
disconnect from the VPN, map busses to Objects, and then reconnect to the VPN.

Some Bed assignments are not imported when importing session data from another Dolby Atmos session. (PT-266332)

In a Dolby Atmos workflow, it is possible to map more than one bus to a single bed. This happens automatically if the busses share the 
same output. However, only one of these busses maintains an explicit assignment to the Renderer. This is indicated on the Bus page of 
the I/O Setup by the Mapping to Renderer checkbox only being available for the one explicitly assigned/assignable Bed bus. These bus-
ses have no functional difference except when importing session data. To ensure all busses are imported, be sure to check both “Main 
Output Assignments” and “Bed/Object assignment and Toggle Settings” in the Track Data to Import section.

Multichannel beds are imported in the wrong channel order if a Dolby Atmos ADM BWF file is dragged and dropped to the 
timeline. (PT-267073)

Multichannel beds are imported in the wrong channel order if a Dolby Atmos ADM BWF file is dragged and dropped to the timeline. 
To avoid this, use Import Session Data.

Object Control Mode must be set to Master in order for Object metadata to be included in an ADM BWF file. (PT-267165)

It is possible to include an object in a Dolby Atmos ADM BWF file as long as the object is active and used in the session. However, the 
object pan metadata will not be included unless the Object Control Mode is set to Master.

AAE –6101 errors with virtual Core Audio devices when Minimize Additional I/O Latency is enabled (PT-252814)

Minimize Additional I/O Latency may result in AAE -6101 errors when used in conjunction with some Core Audio devices, such as the 
Dolby Audio Bridge or Sound Flower. To avoid this issue, disable Minimize Additional I/O Latency when one of these devices is se-
lected for the Pro Tools Playback Engine.

Ambisonics

Opening a session with Ambisonics tracks in a version of Pro Tools lower than 12.8.2 may improperly convert Ambisonics 
tracks to 7.1.2 or 7.1 format tracks rather than dropping them (PT-233217)

When opening sessions that contain Ambisonics tracks in versions of Pro Tools lower than 12.8.2, Pro Tools may improperly convert 
Ambisonics tracks to 7.1.2 or 7.1 format tracks rather than dropping them. Since Ambisonics channels do not correspond to speaker-
mapped channels, these tracks should be deleted or made inactive as they are unusable in versions of Pro Tools lower than 12.8.2.

General Localization

Problems Rendering Online Help if Pro Tools Language Support is set to Simplified Chinese (PT-264670)

Avid’s Online Help Center is not rendered correctly inside of Pro Tools when the Language Support is set to Simplified Chinese. To 
View the Help content either switch Pro Tools language to English or open the page in an external browser.

https://avid.secure.force.com/pkb/articles/readme/Pro-Tools-7-1-2-Channel-Order-Change
https://avid.secure.force.com/pkb/articles/readme/Pro-Tools-7-1-2-Channel-Order-Change
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Relinking using MacDrive Version 6 to open sessions from other platform (PTSW-63606)

MacDrive version 6 strips the extensions off of files in “Normal Use” mode - you need to use “Backup/File Transfer” mode to avoid 
having the extensions stripped off. However, “Backup/File Transfer” doesn't work well with multibyte characters, as “International 
Use” does. “International Use” also strips the extensions, so you either have to not use multibyte characters, or have the trouble with 
stripping extensions. These used to be separate options in MacDrive 5, but in 6 you can't get one without the other. To get around the 
stripping extensions, you can do a Relink by ID only, and have it search through all the files to match them up - this is the only work-
around.

AAF/OMF sequences with non-English characters import with garbled clip names or won't relink (PTSW-33569, PTSW-99570, 
PTSW-33826) 

If an AAF/OMF sequence containing files or clip names with non-English characters is exported from a Mac-based Pro Tools 7.3.1 sys-
tem (or lower), it may not import correctly into Avid Media Composer, or Pro Tools 7.4 and higher systems on Windows or Mac. Con-
versely, AAF/OMF sequences with non-English characters exported from any Pro Tools 7.4 or higher system (or higher) may not im-
port correctly into a Mac-based Pro Tools 7.3.1 (or lower) system. To relink the files, select “Manually Find and Relink,” then deselect 
all options except “Find by file ID.” Clip names may appear garbled.

Inconsistent MIDI performance on Dutch OS with English Pro Tools (59608)

When running the English version of Pro Tools on Dutch OS, MIDI output can slow down with extended use.

Known Issues with Audio Interfaces
Avid DigiTest firmware updates appear to freeze when DigiTest is not the front-most application (PTSW-138994)

When clicking outside the Avid DigiTest window, the Graphical User Interface (GUI) may appear to freeze. However, the firmware up-
date will complete successfully. If you encounter this issue, please wait for the firmware upgrade to finish. You will know that the firm-
ware update completed successfully when the GUI becomes responsive again.

When switching audio interfaces, some devices may fail to load proper drivers with the Found New Hardware wizard 
(PTSW-28118)

When switching audio interfaces, the Found New Hardware Wizard will sometimes properly identify the device, but then fail to install 
the needed drivers. If this happens, with the new device connected, go to Add or Remove Programs in the Windows Control Panel, 
choose the audio interface, select Change, and run a “Repair” install. The driver installation should complete with the Found New Hard-
ware Wizard.

Changing sample rates during a session can cause session to play at a faster or slower speed (56697)

Changing Sample Rate during a session from the Control Panel for your audio interface can cause the audio to playback at the incorrect 
speed. Consequently, the data could be unrecoverable afterwards. Before creating a session, set the Sample Rate in the Control Panel 
for your audio interface and do not make changes thereafter.

Pro Tools | MTRX Studio

Hardware Setup displays “Loop Master: N/A” (PT-259483)

If two MTRX Studio units are connected to a single Pro Tools system, Hardware Setup displays “Loop Master: N/A.” To avoid this is-
sue, use only one unit per Pro Tools system (select the unit you want to use in the DADman Device List and deselect all other units).

HD OMNI

Noise in the output signal from HD OMNI with digital input (PTSW-1614)

If HD OMNI is connected to a digital source with a mismatched clock and Sample Rate Conversion (SRC) is not enabled, you will hear 
noise (including loud “pops”) in the output signal. To correct this problem, either enable SRC or ensure that the clock of the digital 
source and HD OMNI are matched correctly.
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HD OMNI front panel Setup menus are unresponsive after Pro Tools quits unexpectedly (PTSW-125692)

HD OMNI will not automatically recover “stand-alone” mode if Pro Tools quits unexpectedly (or if you disconnect the DigiLink cable 
from HD OMNI while Pro Tools is running). As a result, some of the SETUP functions accessible from the front panel will be unavail-
able. Power cycle HD OMNI to recover stand-alone mode.

Graphic redraw problems in the Hardware Setup dialog (PTSW-122690, PTSW-1346, and PTSW-1235)

When changing the Hardware Setup configuration for HD OMNI, it is possible to encounter graphics redraw problems in some cases. 
To force a graphics redraw of the Hardware Setup dialog, close and reopen the Hardware Setup dialog.

No sound on output after Hardware reset (PTSW-126575)

After resetting the HD OMNI interface to the default factory settings using the front panel controls, the HD OMNI interface stops emit-
ting sound in sessions where the outputs are not assigned to the Monitor output path. To correct this problem, press the ALT monitor 
button to switch to the ALT Monitor path, and then press it again to switch back to the Main Monitor path. 

Loss of monitor path with launching Pro Tools with HD OMNI off or disconnected (PTSW-127313)

When launching Pro Tools and opening I/O Setup after powering off HD OMNI or disconnecting it from the system, the inactive Mon-
itor path is not present in Output tab. You may need to restore the default I/O Settings and remap the corresponding Output Busses.

Output paths are not automatically created in the Output page of the I/O Setup after disabling the corresponding monitor path 
in the Monitor page of the Hardware Setup, and re-assigning the outputs from “None” to physical outputs in the Main page of 
the Hardware Setup (PTSW-127559)

After disabling the Monitor path in the Monitor page of the Hardware Setup and re-assigning the corresponding Outputs from “None” 
to physical outputs (such as “A 1–2”) in the Main Page of the Hardware Setup, these Output paths are not automatically created in the 
Output Page of the I/O Setup. You will have to manually create the appropriate Output paths in the I/O Setup (or click Default).

Changing monitor path output assignments in the Hardware Setup does not update the output paths in the Output page of the 
I/O Setup (PTSW-127563)

When changing Monitor path Output assignments in the Monitor page of the Hardware Setup (such as setting the Monitor path Format 
to None or assigning the Monitor to different physical outputs), the Output paths in the Output page of the I/O Setup do not reflect the 
corresponding changes. You will have to manually create the appropriate Output paths in the I/O Setup (or click Default).

When creating new sessions, using the I/O Settings selector can result in unexpected output assignments if HD OMNI has an 
assigned Monitor path (PTSW-123896)

If HD OMNI has an assigned Monitor path, Output paths created by the selected I/O Settings option in the New Session dialog may be 
offset by the channel width of the Monitor path. If this happens, you will have to manually create the appropriate Output paths in the 
I/O Setup (or click Default).

I/O Setup Bus page erroneously adds Monitor paths (PTSW-127739)

With both MAIN and ALT Monitor paths declared, toggling one of the CR Monitor paths from the current format to “None” and then 
back to the starting Monitor format from within the Hardware Setup Monitor page, causes the Bus page in I/O Setup to erroneously add 
an extra Monitor path with the abbreviation with “(1).” This can happen numerous time and each new Monitor abbreviation increments 
accordingly.

Avid Audio Interfaces with ASIO Third Party Client Software

When adjusting the Hardware Buffer Size in a third-party audio application (such as Reason), the Avid Hardware ASIO driver 
may quit unexpectedly (PTSW-162469, PTSW-154719)

It is possible to select an unsupported hardware buffer size for some Avid audio interfaces when using third-party ASIO client software 
(such as Reason or Cubase). To avoid this issue, use the Avid hardware driver control panel to change the hardware buffer size.
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Mbox Pro

Pro Tools appears unresponsive with Mbox® Pro (PTSW-184498)

If Pro Tools appears to be unresponsive with Mbox Pro, check to ensure that the Mbox Pro is synchronized to the proper clock source 
(Setup > Hardware) and that the clock source and your Pro Tools session have matching sample rates. If Mbox Pro encounters a problem 
with the clock source (such as mismatched sample rates between the clock source and the session), Pro Tools may become unrespon-
sive.

ASIO and WASAPI

Pops and clicks can occur when using third-party ASIO audio interfaces with Pro Tools (PTSW-132084)

Note that audible pops and clicks can occur when using some third-party audio interfaces even if Error Suppression is disabled. Try in-
creasing the Hardware Buffer size for the device to avoid this problem.

Pro Tools cannot locate installed ASIO hardware on launch (PTSW-132125)

There are known issues with some third-party ASIO devices not being recognized by Pro Tools 10.x. For a list of third-party hardware 
compatibility issues, please visit www.avid.com/compatibility.

When using Pro Tools or Pro Tools HD with WASAPI or ASIO, Pro Tools cannot create or open sessions that have a different 
sample rate than Windows default audio interface (PT-201662)

When using Pro Tools or Pro Tools HD software with WASAPI, Pro Tools cannot create or open sessions that have a different sample 
rate than Windows default audio interface. To avoid this issue, exit Pro Tools, disable the audio interface in the Windows Control Panel, 
and then launch Pro Tools to create or open a session using the desired sample rate.

Pro Tools fails to launch if video hardware is seen as the default audio interface for Pro Tools (PT-223463 and PT-237198)

If video hardware is installed after installing drivers for your audio interface, Pro Tools may hang on launch. Should this occur, force 
quit Pro Tools in task manager and relaunch Pro Tools while holding down the N key on your computer keyboard. This will cause the 
Pro Tools Playback Engine dialog to launch. Change the playback engine from the video hardware to any supported audio interface.

Error Messages
Error –6031 during playback (32637)

If you encounter a –6031 error while playing back a session with dense MIDI or automation, stop playback, save and close the session, 
quit and re-launch Pro Tools, then re-open the session before resuming playback.

DAE Error –9132

If a –9132 error occurs during Bounce To Disk (even with the highest Hardware Buffer setting selected), bus the desired tracks to the 
appropriate number and format (mono or stereo) of audio tracks, then record them to disk instead of bouncing.

Error –5000 (Unknown Error) when launching Pro Tools (36130)

On a system with multiple partitions, if different InterLok PACE versions are installed on different partitions, Pro Tools will report an 
“Unknown –5000 error” on launch. To avoid this problem, install the same PACE components on all partitions on your system.

Error –6042

If you repeatedly encounter –6042 errors, open the System Usage window and check the PCI gauge. If the gauge is peaked, you will 
need to reset the PCI bus. To reset the PCI bus, make all tracks inactive and start playback. If you still encounter a –6042 error, quit and 
relaunch Pro Tools, open the Playback engine dialog, and change the Number of Voices to a setting that uses fewer per DSP. 



 Pro Tools and Pro Tools | Ultimate Software 2021.10 on Windows 10 — 10/27/21 34

Error –6074 when toggling all plug-ins between Active and Inactive mode during playback (55049)

In large sessions, deactivating and reactivating all the plug-ins simultaneously can cause Pro Tools to post the following error: “The en-
gine DSP ran into the TDM2 deadband. Too many I/Os to the TDM2 chip (–6074).” To resolve the problem, activate and deactivate 
plug-ins in smaller groups.

Error –9073 when recording to a FireWire drive and the 2 GB file limit is reached (42611)

When the 2 GB file limit is reached during recording to FireWire drives, a –9073 error is posted instead of the expected “Recording has 
been terminated because a disk is full” dialog. This error is benign, and does not signal any data loss or problem with the hard drive.

Error –9073 other than when recording to a FireWire drive and the 2 GB file limit is reached

If you encounter a –9073 error, refer to the Answerbase for possible causes and solutions (www.avid.com/us/support).

Error –9128

In sessions with high sample rates (96 kHz or higher), you may need to set the Hardware Buffer Size to 512 or more to avoid –9128 er-
rors during playback with Native plug-ins or dense automation.

Error –9155

In sessions with high sample rates of 96 kHz or more, you may need to set the Hardware Buffer Size to 512 or more to avoid –9155 er-
rors during playback with dense automation.

Error –9735

When Pro Tools reaches the end of its time limit in the Timeline, or if Pro Tools has been in continuous play for longer than the maxi-
mum time limit, you will encounter a DAE error –9735. The maximum time limit for Pro Tools depends on the session sample rate. For 
more information, see the Pro Tools Reference Guide.

https://www.avid.com/us/support
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